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Preface

The Adobe Photoshop™ program is photo-retouching, image-editing and color-
painting software for the novice and professional alike. This guide describes the
Adobe Photoshop program, from its basic functionsto its advanced photodesign
and color printing features.
The book containssix sections.

Section 1: Getting Started

Section 1 explains how to start using Adobe Photoshop software, including how
to create new documents, open and save documents, and work with several
documents open at once. The section explains the different image types and for-
mats with which the Adobe Photoshop software works.

Chapter 1, “Managing Documents,” describes the steps involved in creating new
Adobe Photoshop documents, opening existing documents and documents
saved in otherfile formats, and saving documents in the Adobe Photoshop
format andin otherfile formats. The ability to save in a variety of file formats
allows you to use images created or edited in Adobe Photoshop software in other
application programs and on other computerplatforms.

Chapter2, “Scanning, Importing, and Exporting Images,” discusses how to scan
images, and how to import documents and export Adobe Photoshop documents
so the documents can be used on other computer platforms and in other appli-
cations.

Section 2: Using the Adobe Photoshop Toolbox

Section 2 describes the Adobe Photoshoptoolbox andgives a detailed description
of howthetools work.

Chapter 3, “Managing the Toolbox,” gives a brief overview ofall the tools in the
toolbox and how they work.

Chapter 4, “Controlling the Artwork and Screen Display,” describes how to zoom
in and out from an image for a more detailed or greater view, scroll through a
window, change the windowdisplay, and use rulers to make measurements on
an image.

Chapter 5, “Using the Painting Tools,” explains how to use the painting tools to
alter an image or to create original artwork, The painting tools include the pencil
tool, line tool, paint brush, paint bucket, and airbrushtools.

Chapter6, “Using the Editing Tools,” covers how to use the editing tools to
retouch or customize an image. The editing tools include the eraser, the smudge
tool, the blur tool, and the sharpen tool.

17

XV



18

xvi User Guide

Chapter 7, “Painting and Editing Tool Options,” explains additional features
commonto the painting and editing tools that allow you to choose a brush shape
for each tool and specify the opacity (transparency) of the paint used by the tool.

Chapter8, “Using the Type Tool,” explains how to add type to an imageto create
a posteror special effect, and it covers how to choosea type font, size, and type
styles.

Chapter 9, “MakingSelections,” covers various selection techniques including
using selection commandsandtools and their options to select part of an image
based on the similarity of pixel colors.

Chapter 10, “Using the Fill Tools,” describes howtofill part of an image.It also
explains how toselect colors to paint and fill an image with a solid color.

Chapter11, “Selecting Colors,” includes the various waysto select the foreground
and backgroundcolors that are used by the Adobe Photoshop program tools,
including from an image, and from either the Color Picker or the Color Wheel
dialog box.

Section 3: Basic Image Editing

Section 3 covers howto edit an image, including howto cut, copy, paste, resize,
and transform images.

Chapter 12, “Cutting and Pasting Selections,” shows howto cut, copy, and paste
a selection within an image, Pasting instructions include pastingaselection inside
and behind anotherselection, and using paste controls to determineprecisely
how a selection appears whenit is pasted onto an image.

Chapter 13, “Transforming Images” discusses how to transform an image by
rotating, skewing, or stretching.

Chapter 14, “Resizing Images” describes how to crop an imageto eliminate extra-
neous portions, and resize and change the resolution of an image.

Section 4: Advanced ImageEditing and Color Correction

Section 4 describes how to convert images to different image types, make color
corrections, edit an image’s color table, and changingthecolorlevels of pixels.It
also describes how to use filters to modify images.

Chapter 15, “Converting Images and Working with Channels,” describes how to
convert images of one type to anotherin preparation for printing the image, how
to edit a document's color table to adjust or correct the colors in an image, and
how to manipulate an image’s channels, or further alter the image.

Chapter 16, “Making Color Corrections,” discusses the procedures for changing
the colors in an image by comparing or mappingthecolors of pixels in the image
to other colors, This chapter also contains information on how you can use the
Adobe Photoshop program to adjust the color levels of pixels. Included are the
procedures to adjust the brightness, contrast, and gamma in an image.
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Chapter 17, “Using Filters to Modify Images,” describes the manyfilters available
with Adobe Photoshop software to alter an image, and how to use them.It
explains how to usefilters to soften, sharpen, offset, outline, and brighten an
image, and create such special effects as adding noise. It also describes how to
create a custom filter.

Section 5: Printing Images

Section 5 explains the procedures for printing images, including printing half-
tones and color separations.

Chapter 18, “A Printing Overview,” introduces basic concepts of printing and
how to prepare an imagefor printing. It explains how to print a halftone of a
gray-scale image, including the ability to print registration and crop marks,
calibration bars, borders, and labels on images..

Chapter 19, “Printing Halftones,” explains in detail how to print a halftone of a
gray-scale image. It shows how to specify the screen frequency and angle, and
howto specify the dot shape used for the screen. This chapter also explains how
to make calibrations to compensate for different printers and printing presses.

Chapter 20, “Producing a Color Separation,” covers the procedures for printing a
four-color separation of a color image. The chapter explains howto calibrate the
image to be printed using the on-screen display, and how to compensate for
density changes on the output device. It also explains how to make the required
calibrations of the four separations, and how to compensatefor different printers
and printing presses.

Chapter 21, “Tips and Troubleshooting,” contains tips and techniques as well as
solutions to problems you may encounter when making color corrections, print-
ing images, using the Adobe Photoshop program, and using the program in con-
junction with the AdobeIllustrator” program.

Section 6: Reference Material

The Appendix, “Photoshop Color Swatches,” contains color swatches for adjust-
ing the color displayed on your monitor. The Glossary defines terms used
throughoutthe user guide.

Before beginning to use the Adobe Photoshop program, you should set up your
Macintosh andbe familiar with its use. You should know howto use the mouse

and standard Macintosh menus. If you need to review these techniques, refer to
your Macintosh documentation.

Preface xvii
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Introduction

Welcome to the Adobe Photoshop program.

A darkroom on the desktop, the Adobe Photoshop program is extraordinary
photo-retouching, image-editing, and color painting software for pixel-based
images. Whether youare a professional or a novice, with the Adobe Photoshop
program you'll quickly be able to enhance, retouch, and compose scanned
images, original artwork, and other pixel-based graphics on the Macintosh.

The Adobe Photoshop program is a sophisticated graphics application program
designed to allow graphicartists, photographers, desktop publishers, and other
people who work with graphic images to create and manipulate digital images.
You can use Adobe Photoshop tools and commandsto paint new imagesorre-
touch existing digital images that were created by a scanner, video capture equip-
ment, or some other means.

The Adobe Photoshop program supports a variety of pixel-based images in more
than a dozen formats. As a result, the Adobe Photoshop programis a versatile,
powerful tool useful in applications from photo retouching and color separation
to animation, and on a variety of platforms, from monochrometo 32-bit color
systems.

You'll find that the Adobe Photoshop program excels as an art production tool,
whether you are an art director or electronic publisher who needs to merge and
edit color images, a photographer who wants to retouch proofs, or a graphic de-
signer whois creating original or composite artwork including collages and photo
montages. The softwareis equally useful to printers and service bureaus that want
to generate color separations, to animators who wantto colorize images and pro-
duce audio-visual materials quickly, and to artists who want to create new art-
workusing the latest media and tools.

With the Adobe Photoshop program, you work with bitmapped images that are
composed ofa series of dots or picture elements (“pixels”). When you “paint” in
a pixel-oriented program like Adobe Photoshop, you changethe colorsof pixels.
The numberof colors that you can workwith at a time depends on the amount
of color information available for each pixel. On an 8-bit color system, a maxi-
mum of 256 different colors can be displayed simultaneously. On a 24- or 32-bit
color system, over 16 million different colors can be displayed at one time. The
amountof information used for each pixel affects thefile sizes of images: a 24-bit
RGB image has three times as much information as an 8-bit gray-scale version of
the same image, and so takes up three times as much disk space.

You can use the Adobe Photoshoptools to create an original image, while image
processing functions allow you to edit scanned and other digitized images. With
the painting tools in the Adobe Photoshop program, you can add lines to an
image, fill an image with color, and spray-paint on parts of an imageas if you
were using an airbrush to retouch a photograph.
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You can edit images in many ways. You can crop images and perform transfor-
mations on images, such as rotating, skewing, andflipping. You can also use the
manyfilters in the Adobe Photoshop program to modify images by sharpening
and blurring an image, and creating mosaic andfaceteffects.

AdobePhotoshopsoftware allows you to perform color correction on images, too.
You can adjust the levels of color in an image, as well as the brightness and
contrast. You can also use the Adobe Photoshop program to changetheresolu-
tion at which the imageis printed onaprinteror film recorder, or output to some
other media.

Whenyou are ready to generate a hard copy of an image, the Adobe Photoshop
program includesthe ability to create and print halftones and color separations.
You can automatically convert images that are in the RGB(red, green, and blue)
format, which is commonly used to display images on-screen, into the CMYK
(cyan, magenta, yellow, and black) format used to print images on a printing
press.

Imagetypes that the Adobe Photoshop program supports include bitmapped,
gray-scale, indexed color, RGB, CMYK; and hue, saturation and brightness (HSB);
huesaturation, and luminance (HSL), and multichannel images. Supported
image formats include the default Photoshop and Raw formats; formats suitable
for graphics and page layout applications including EPS, MacPaint®, PICT, Pixel-
Paint®, and TIFF formats; those useable by PIXAR workstations, Scitex image-
processing, and Commodore Amiga computers; a format for Targa video boards;
and a format for ThunderScan,

The Adobe Photoshop program stores images in channels, similar in concept to
a plate in a four-color (four-plate) printing process. A bitmapped image and gray-
scale image are single-channel images; RGB, HSL, and HSB images have three
channels; CMYK images have four channels.In addition, alpha channels can be
added to an image to manipulate the image and store masks,

Throughoutthis user guide, references are madeto adjusting color levels. For the
sake of consistency, this term applies to all image types, whethercoloror gray-
scale.

What you need

User Guide

® MacintoshII, IIx, Ilex, Ici, SE, or SE/30
@ Hard disk

@ 2 megabytes random-access memory (RAM)

@ Apple system software version 6.0.2 or later

In addition, a gray-scale or color monitor is recommended, and a Macintosh-
compatible scanneris optional.
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Using this book
This book is divided into six sections. For information about creating new docu-
ments, opening, closing, and saving documents, you should read the chapters in
Section 1, “Starting Out Using the Adobe Photoshop Program.” If you are inter-
ested in learning howto use the painting, editing,fill, selection, and other tools
to create an original image or edit an existing image, you should read the chapters
in Section 2, “Using the Adobe Photoshop Toolbox.”

For information about basic image editing, see Section 3, “Basic Image Editing.”
To learn how to makecolorcorrections in an image and perform advanced image
editing, you should read the chapters in Section 4, “Advanced Image Editing and
Color Correction.” If you want to know how to output an image, you should read
the chapters in Section 5, “Printing Images.” Section 6, “Reference Material” in-
cludes the Photoshop Color Swatches, the Glossary and the Index.

The Adobe Photoshop program package
The Adobe Photoshop program package contains

@ The program disk

@ The tutorial disk, containing two sample images

@ A program disk containing software designed by third-party software
developers
@ Thecalibration disk

@ Adobe Photoshop User Guide

@ Adobe Photoshop Tutorial

@ The Adobe Photoshop Quick Reference Card

@ Registration card and envelope

Registration
Adobe Systems wants to keep you informed of the latest changes and improve-
ments made to the Adobe Photoshop program and provide technical support if
needed. To do that, we need to know who youare.Pleasefill out the enclosed
registration card and mail it to us.

You must send in your registration card to receive technical support. The card
also lists ownership benefits.

Third-party development
AdobeSystemsis interested in working with third-party software developers on
the continual enhancement of the Adobe Photoshop program.

If you are interested in writing a plug-in module to support your input or output
device, or in adding additional file formats, please contact Adobe Systems.

Introduction 3
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Beginning with a scan of grape leaves, theartist selected individual elements to paste
into the new design. The Feather commandwasusedto soften the edgesof the
selections. The Rotate and Paste Into commandswere usedto position the elements.

The background wascreated byfirst converting a copy of the grape leaves image to
gray-scale. The gray-scale image wasthen pasted ontopofthe original color image of
the grape leaves, Paste controls were used to make the gray-scale imageslightly
transparent, allowing someofthe original color to show through.
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Chapter 1: Managing Documents

Adobe Photoshop software works with original artwork or with existing images
that were created by other applications or digitized by a scanner, video camera,
or other means. Whether created or imported into the Adobe Photoshoppro-
gram, imagesare stored as documents and displayed within windows. To use the
Adobe Photoshop images included on yourtutorial disk, you simply open the
images.

This chapter explains how to begin using the Adobe Photoshop program, and
how to open, save, and manage image documents.

To work with an image, you open the documentthat contains the image. The
document displays the image in a window.

Before you start to use the Adobe Photoshop program, turn on your computer
and check to make sure that you have everything you need, See “What you
need,” in the Introduction earlier in this guide for a description of the require-
ments,

Make a backupcopyof the program disk that you can work with. If you need help
making a backup copy, see your Macintosh user guide for instructions. Use the
backup copyto install the Adobe Photoshop program on yourhard disk.

Double-click on the Adobe Photoshopprogram disk icon on the desktop. Thefirst
time you start the program, a dialog box appears asking you to personalize your
copy of the program.

Please personalize your copy of Adobe Photoshop™:

 
Type your name and the nameof the organization you work for, if applicable.
Enter the serial numberlisted on your Adobe Photoshopregistration card or
manuals, and click OK.
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Whenyoufirst start out using the Adobe Photoshop program, you are asked to
create a preferences file. The preferences file holds the preference settings you
choose in the Adobe Photoshop program. Thepreferencesettings include the sep-
aration setup information, display options, and options for exporting informa-
tion to the Clipboard. The settings you save are used in all Adobe Photoshop
documents.

You can change the nameofthefile as well as its location. You should keep the
preferencesfile in a separate folder outside of the System folder. The location of
the preferences file governs which hard drive the Adobe Photoshop program uses
for virtual memory.If your system does not have enough random-access memory
(RAM)to store large documents, Adobe Photoshop uses virtual memory, which
accesses the hard disk, to automatically write and read image data to and from
your hard disk. Make sure that you locate your preferencesfile on a disk that has
enough space and speed for your needs.

The location of the preferencesfile also determines where the Adobe Photoshop
program looks for plug-in modules. Plug-in modules are third-party developed
programs that extend the capabilities of the Adobe Photoshop program to
interface with new scanners and non-standardprinters, to support additionalfile
formats, and to include advanced, special effects filters.

Thefirst time you use the Adobe Photoshopapplication, a dialog box appears,
| asking you to locate the preferencesfile.

To create a new preferencesfile:

. Click New.

The Save As dialog box appears.

. Use the drive and directory buttons(if necessary) to choose where you want to
store thefile.

As an option, type the desired namefor the preferencesfile. By default, the file
is named “PS Prefs.”

Click Save.

A new preferences(PS Prefs) file is created and stored in the specified location on
disk.

Whenyoustart and quit the Adobe Photoshop program, the software looksfor
| the preferencesfile. If the preferences file has been moved from thelast location
where the program foundit, a dialog box appears, asking you to locatethefile.

To locate the preferencesfile:

.| Use the drive and directory buttons to locate the preferencesfile.

‘| Click the preferences file name.
Click OR.
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The Adobe Photoshop program will store the location of the preferencesfile and
access the file automatically when you start up the application in the future.

After you have performed these preliminary steps, the Adobe Photoshop program
startup screen appears, followed by the program's desktop.

File Edit Mode image Select Window

ot

|

eed)

el

OLA

eOO

 
You are ready to open a document andstart working.

Opening images
Images that you are not currently working on are stored in documents on disk.
Whenyou workon an image in the Adobe Photoshop program, the imageis nor-
mally displayed inside a window.

The Adobe Photoshop program opens and displays all documents at 72-dpi
screen resolution. This may cause a documentto appear enlarged on-screenif the
resolutionof the original image is greater than 72 dpi. For example, a document
that you scanned in at 300 dpiwill be displayed at 72 dpi and therefore, will
appearlarger on-screen; however, the document will print at the samesize as the
original image.

Opening a new document

Whenyou create a new Adobe Photoshop document, you can specify the size of
the overall image area, the image’s resolution, and whether you wantto create a
gray-scale or an RGB color image.

Chapter 1: Managing Documents—7
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Resolution, here, refers to the numberof pixels per inch that are used in the
image. This “image resolution” determines how muchinformationis used in the
image and how muchinformationwill be sent to the printer when youprintit.
The image resolution is measured in pixels per inch, whereas the resolution of
output devices (such as printers) is measured in dots per inch (dpi). You can out-
put images at resolutions of more than 2500 dpi on an imagesetter, but you nor-
mally won’t use an image resolution that high because the printer doesn’t require
that much information to produce high-quality results. In addition, an image at
a resolution of 2500 dpi would result in a document probably several hundred

megabytesin size.

Theresolution you specify for new documentsaffects the amountof information
used in the document, which in turn affects the quality of the output and the
amountof disk and memory space the documentrequires. By default, the Adobe
Photoshop program selects RGB color as the image type, 512-pixels-by-512-pixels
for the width and height, and 72 pixels per inch for the resolution. If you cut or
copy a selection in an existing image and then create a new documentinto which
you will paste the selection, the dimensionsof the selection on the Clipboard are
automatically entered in the Width and Height text boxes.

When youspecify the size and resolution, you can also specify the units of mea-
sure you want to use. For the width and height, you can choosepixels, inches,
centimeters, points, picas, or columnsas the units. You can chooseeither pixels
per inch (pixels/inch) or pixels per centimeter (pixels/cm) as the units for the
resolution.

The current background color displayed in the toolbox becomes the background
color for your new image.

To create a new Adobe Photoshop document:

. Choose New from the File menu.

The New dialog box appears.

New...

wiath: [winetsy Cancel

Resolution:

Mode:

© Gray Scale
@ RGB Color
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2. To change the default settings, click Gray Scale if you want to create a gray-scale
image.

3. To select the units of measure, position the pointer on the box beside the param-
eter you want. Press down the mouse button.

A pop-up menu appears.

4, Holding down the mouse button, drag to highlight the units you want. Release
the mouse button.

5. To enter values for the parameters, type a value for the width in the Width text
box, and press the Tab key.

6. Enter a value for the Height in the Height text box, and press the Tab key.
7. Enter a value for the desired resolution in the Resolution text box.

8. Whenyouhavefinished defining the parameters for the new image, click OK.

A new, untitled document appears.

Opening existing documents

To open existing Adobe Photoshop documents as well as documents saved in
otherfile formats in the Adobe Photoshop format, follow these steps.

1. Choose Open from the File menu.

The Open dialog box appears.

J Photoshop Images

Be aL been

0 Fire Engine
D Flowers
1 Horses
D Koala
D Machine
D Ram

File Format: Photoshop

 
2. Use the drive and directory buttons, if necessary, to locate the folder that con-

tains the document you want to open.
3. Click the document.

4. Click Open.

Chapter 1; Managing Documents 9
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Resizing a newly opened document

If the image you open appears enlarged, you may wantto resize it to print the
image atits original size or to view the entire image on-screen.

To display the current dimensionsof the image, position the pointer on the size
box in the lower-left corner of the image, and Option-click. If the dimensions of
your image have changed, you can change the imagesize using the Size/Ruler
option in the Page Setup dialog box in the File menu; the option will cause the
image to print at its accurate size, but will not affect how the image appears on-
screen. If your image has been enlarged and you would like to see the entire image
on-screen, use the zoom tools.

It is recommended that you do not use the Resample command in the Image
menu to resize the newly opened image, because you could alter the pixel infor-
mation in the imageandirretrievably lose image information. For more informa-
tion about the resampling feature, see “Resampling imagesprecisely,” in Chapter
14, “Resizing Images.”

Working with multiple documents

User Guide

You may sometimes want to have several Adobe Photoshop documents openat
the same time and switch back and forth between them. Alternating between
windowscan be useful when you want to compare twoversions of the same
image or use one image to correct the color in another.

Only one document can be the active window at a time. You can work only in
the active window,with the exception of when you use the eyedroppertool. The
eyedroppertool is unique becauseit allows youto select colors from an inactive
document window without activating the window. To switch between windows,
you can click on the window you wantto activate, or you can choose the window
you wantto activate from the Window menu.

To select the active window when working with multiple documents:

1. Select any of the tools in the toolbox except the eyedroppertool.

. Click the window you wantto activate; or choose the desired window from the
Window menu.
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Saving documents
Whenyou save a new documentforthefirst time, you specify the name of the
document and where on disk you wantto store it. You should save a new docu-
mentat an early stage to preserve the work you have doneonit. You should also
save existing documents periodically to protect the changes you made.

By default, all new documents are saved in the Adobe Photoshopfile format.
To save a document:

1. Choose Save from the File menu.

If the document has never been saved, the Save As dialog box appears. 

Photoshop Images
iy Faucet HD 100

i) Fire Engine
i Flowers

i" Drive

DY Machine

Save this documentas:

File Format:|Photoshop
 

2. Type a namefor the document.

3. Use the drive and directory buttons(if necessary) to choose where you want to
store the document.

4. Click Save.

The documentis saved on disk with the specified nameandin the specified
location.

Chapter 1: Managing Documents 11
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Saving a copy of a document

You can also automatically create and save copies of a document using the Save
As command. The Save As commandalso allows you to save Adobe Photoshop
format documentsin otherfile formats. For information about saving documents
in otherfile formats, see the section, “Exporting images,” in Chapter 2, “Scan-
ning, Importing, and Exporting Images.”

To save a copy of a document:
. Choose Save As from the File menu.

The Save As dialog box appears.

2. Type a namefor the copy.

3. Use the drive and directory buttons(if necessary) to choose where you wantto
store the copy.

. Click Save.

A copy of the active documentis saved on disk with the name andin the location
you specified.

Closing documents

Whenyou havefinished working on a document, you can closeit to storeit. If
you close a documentthat contains unsaved changes, an alert dialog box will ap-
pear to ask if you wantto save the changes. Click No to close the document and
discard any changes you madesince youlast saved the document. Click Cancel
to resume working on the document. Click Save to save the changes.If the doc-
ument has never been saved in the Adobe Photoshopfile format, the Save dialog
box will appear.

To close a document, choose Close from the File menu,orclick the close box on
the active window.

Quitting the Adobe Photoshop program

12 User Guide

Whenyouhavefinished using the Adobe Photoshop program, choose the Quit
commandfrom the File menu.If there are any documents open that contain un-
saved changes, the program will prompt you to save the changes.
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~ Chapter 2: Scanning, Importing, and Exporting Images

a Images can be brought into the Adobe Photoshop program by scanning a photo-
graph,slide, or image, or by importing electronic artwork created with a drawing

oe program. You can import an image document in one format, and exportit in
another, depending on your needs. As a result, you can easily transfer Adobe

a Photoshop documents to other applications and computer platforms.

You can save Adobe Photoshop documents as encapsulated PostScript® files or
TIFF documents, then place the documents in your page layout program. You can
also export Adobe Photoshop documents in formats that can be read by IBM®-
compatible and Commodore Amiga® computers, PIXAR® workstations, and
Scitex® image-processing systems.

Scanning images
The Adobe Photoshop program in conjunction with certain brands of scanners
allows you to control the process through which a hard copy of an image, such
as a photographora slide, is converted into a digital image.

o Adobe Photoshopsoftwaredirectly interfaces with any scannerthat has an Adobe
Photoshop-compatible scannerdriver. Check with your scanner manufacturer to
determine the compatibility of your scannerdriver.

To install the desired driver, simply drag it into the samefolder that contains your
Adobe Photoshoppreferencesfile; this folder should not be the System folder.All
plug-in modules are loaded when the Adobe Photoshop programstarts. Soif the
Adobe Photoshop program is running when youinstall the plug-in module, you
must quit the program andrestartit.

If the scanner you are using does not have an Adobe Photoshop-compatible
scannerdriver, you can use the manufacturer's software to scan your images, save
them as TIFF or PICTfiles, and import them into the Adobe Photoshop program.

Importing images
a The Adobe Photoshopprogramallows you to import documents in 14 formats in-

cluding Photoshop, Raw, EPS, TIFF, PICT File, PICT Resource, Amiga IFF/ILBM,
aa CompuServe GIF, MacPaint, PIXAR, PixelPaint, Scitex CT, TGA (Targa), and

ThunderScan. You can also import documentsin file formats that the Adobe

= Photoshop program does not support by using a plug-in module for the format.
Plug-in modules are discussed later in this chapter in the section “Using plug-in

— modules to import and export images.”

If the four-character code, called the “file type,” is set correctly, you can use the

Open commandto open the document, and Adobe Photoshopwill automatically
select the correctfile format.

35
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You should use the Open As commandif you know that thefile type of the
documentis incorrect and you want to open the documentin the correct format,
or if you want to open a documentin the Raw format. As an example, if you
transfer a TIFF document from an MS-DOS® system to the Macintosh,thefile
type of the documentis often TEXT instead of the correct TIFF. In this case, you
should use the Open as commandto openthefile as a TIFF documentin the
Adobe Photoshopprogram.If the program is unable to open the documentin the
format you havespecified, an alert box will appear.

The default file format when you use the Open As commandis the Raw format.
The Raw formatis a highly flexible file format designed to accommodate images
saved in undocumented formats, such as those created by scientific applications.
When you open a documentin the Rawfile format, a dialog box appears for you
to specify the parametersof the image so that the Adobe Photoshop program can
open the documentcorrectly. The information includes the width and height of
the image(in pixels), the number of channels in the image, and the length of the
header(in bytes). The header precedes the actual image information, and could
include such information as the name of the application that created the docu-
ment. Each character in the header (including spaces) represents one byte.

If you are uncertain of some of the document information, you can enter the in-
formation you know,then use the Guess button. The Adobe Photoshop program
then estimates the other values based on thesize of the document, which appears
in the topleft cornerof the dialog box, and the values you have entered. (Thesize
is measured in bytes. Each byte represents 1 pixel per channel in the image.)

As an example, suppose you knowthesize of the header in the document, but
you don’t knowthe height and width of the image. You can enter the header’s
size in the Headertext box, then click Guess. The Adobe Photoshop program will
guess the numberof rows and columnsthat comprise the image based upon the
document's size on disk and thesize of the header.

You can use the Swap button to changethe default orientation assigned the
image. The Guess option assumesthat the image has a landscape orientation,
with the width greater than the height. If you click Swap, the width and height
values are automatically reversed.

To import a documentin the Raw format:

. Choose OpenAs from the File menu.

The Open Asdialog box appears.

. Use the drive and directory buttons,if necessary, to locate the folder that
contains the document you want to open.

3. Click the document.

4. Click Open.
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The Specify parameters dialog box appears.

Specify parametersof a
(129600 bytes)

Width: (pixels) Cancel

Height: (pixels)

Channels: [1|
Header:[joSs (bytes) 

. Specify the documentinformation by entering the width, height, number of
channels, and header (if desired).

. To estimate the document’s size parameters, enter either the correct height and
width values to estimate the header size, or enter the correct headersize to esti-

mate the height and width. Click Guess.

The Adobe Photoshop program estimates the appropriate value or values and au-
tomatically enters the information in the dialog box.

. To reverse the order of the width and height values, click Swap.

. When youhavefinished entering information about the document, click OK.

The documentis opened.

If you want to open the documentinto a format other than Raw,follow the steps
below.

To import a documentinafile format other than Raw:

. Choose Open As from the File menu.

The Open As dialog box appears.

2. Position the pointer on the box beside File Format.
3. Press down the mouse button.

Chapter2: Scanning, Importing, and Exporting Images 15
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The pop-up menu listing the file formats supported by the Adobe Photoshop
program appears.
 

Si Photoshop Images
D Faucet

O Fire Engin| Photoshop
0 Flowers Amiga IFF/ILBM
1 Horses CompuServe GIF
jet) bs) EPS
O Machine MacPaint

PICT File
PICT Resource
PIHAR
PixelPaint

“Raw
Scitex CT
ToA
Thunderscan
TIFF

 
4. Holding down the mouse button, drag to highlight the file format in which the

document will be opened.
5. Release the mouse button,

The chosen file format appears in the box.

6. Select the documentfrom the directory window and click Open.

Exporting images
The Adobe Photoshop program allows you to export documents in 14 different
file formats: Photoshop, Amiga IFF/ILBM, CompuServe GIF, EPS, MacPaint, PICT
File, PICT Resource, PIXAR, PixelPaint, Raw, Scitex, TGA, ThunderScan, and TIFF.
Theability to export images allows you to use the Adobe Photoshop imagesin
other applications and on other computer platforms.

You can save Adobe Photoshop documentsas EPS or TIFF documents, then place
these documents in page layout programs that support thesefile formats. You can
also save Adobe Photoshop documents in formats that can be read by Commo-

| dore Amiga and IBM-compatible microcomputers, PIXAR workstations, and
|  Scitex image-processing systems.

16 User Guide

38



39

Certain file formats do not support someof the image types available in the
Adobe Photoshop program. For example, you can’t save an RGB imagein the
MacPaint format because the MacPaint format only accepts black-and-white
image data. Formats that aren't available are dimmed. The optionsavailable for Bs
each format are discussed in the section that follows. Where dialog boxes appear
with options, they are displayed.

Export formats
Thefile formats, and the information that can be specified when exporting an
image in the file format, are described below.

Photoshop

Photoshopis the default file format for saving newly created images.

Amiga IFF/ILBM

The AmigaInterchangeFile Format (IFF)/Interlaced Bitmap (ILBM)formatis used
to transfer documents to and from Commodore Amiga computers. You can spec-
ify the image resolution from 1 bit to 8 bits perpixel. 

Amiga IFF/ILBM Options...

Resolution:

©1bit/pixel
© 2 bits/pixel
© 3 bits/pixel
© 4 bits/pixel
© 5 bits/pixel
© 6 bits/pixel
© ? bits/pixel
@ 8 bits/pixel
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CompuServe GIF

EPS

User Guide

The CompuServe® Graphics Interchange Format (GIF) is commonly used to
upload documents to the CompuServe Information Service, and to pass docu-
ments between other types of computers. You can specify the image resolution
from 1 bit to 8 bits per pixel.

CompuServe GIF Options...

Resolution:

1 bit/pixel
© 2 bits/ pixel
©3bits/pixel
© 4 bits/pixel
C5 bits/pixel
() 6 bits/pixel
()? bits/pixel
@ 8 bits/pixel
 
The Encapsulated PostScript file (EPS) format is used by graphics applications.
You can choose preview PICT and encoding options for documents to be saved
in the EPS format. You can also specify if you want the halftone and transfer
function information saved with the document.

Somegraphics applications, like Adobe Illustrator 88™, let you display or “pre-
view” a PICTrepresentation of a PostScript language image saved in the EPS
format, The PICT preview image gives you an idea of what the imagewill look
like whenit is printed and allows you to accurately place the image on the page.
The AdobeIllustrator 88 program lets you preview a monochrome,1-bit per pixel
PICT image. Other applications let you display a 4-bit or 8-bit per pixel image,
which can contain color.
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You also have the option of saving a CMYK documentas five separate EPS docu-
ments. This allows you to save color separations in a format that can be read by
certain applications that use this format, like QuarkXPress®. Four of the docu-
ments will contain the color information: one documentfor the cyan informa-
tion, one for the magenta, and so on. Thefifth documentwill contain a PICT
preview of the image and a low-resolution PostScript language version for proofs.

Whenyou save a bitmap-type image in EPS format, you have the option of
making the white areas in the document appear transparent.

EPS encoding options

The encoding options control what type of information is saved in the docu-
ment, either ASCII or binary. The binary option results inafile that is about half
the size of an image saved with the ASCII encoding option and takes half as long
to transfer to the printer. However, some applications (such as Aldus PageMaker®
and FreeHand®) do not support binary EPS documents. For these applications,
you should select the ASCII encoding option.

Saving halftone screen and transfer function information
in EPS documents

You can choose to include halftone screen information, including the frequen-
cies and angles of the screens, and transfer function information (dot gain cali-
bration) with an EPS document.If you include this information, and placeit in
anotherapplication, such as Adobe Separator", the PostScript interpreterwill use
this information and override the application’s own settings when the color sep-
arations are generated.

EPS Options...

Preview PICT: Encoding:

© None @ ASCII
@ 1 bit/pixel © Binary
© 8 bits/pixel

CJ Include Halftone Screens
CJ Include Transfer Functions 
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MacPaint

The MacPaint format is commonly used to transfer bitmapped images between

Macintoshapplications. You can only save Adobe Photoshop imagesthat are in
the Bitmap image type in the MacPaint format. You can choose to have the image
either centered on the page whenit is opened or placed in the upperleft corner
of the page. To select the placement option you want, click Center or Top-Left
Corner, then click OR.

MacPaint Options...

Position on Page:

@ Center
© Top-Left Corner 

PICT File

The PICT format is widely used among Macintosh graphics and page layout
applications as an intermediary file format used to transfer documents between
applications.

You can specify the resolution of the image, from 1 bit per pixel to 32 bits per
pixel. The 8-bits per pixel System Palette option lets you automatically select the
system color table as the color table used for the image. This option allows you to
makesure the colors in the selection are displayed properly within applications
that do not recognize custom color tables used to create an image.

PICT File Options...

Resolution:
Cancel

© 1 bit/pixel
© 2 bits/pixel
© 4 bits/pixel
©) 8 bits/pixel
(>) 8 bits/pixel, System Palette
© 16 bits/pixel
@ 32 bits/pixel
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PICT Resource

PIXAR

 
The PICT resource allows you to export an Adobe Photoshop documentasa start-

up screen or include the documentas a PICT resource in an application program. 9
You can specify information about the document that determines how the
resource will be used. If you wantto use the imageas a resource in an application
program, you must enter the information the application needs to make use of
the resource including the file type and file creator IDs, the resource ID, the re-
source name, and the image’s resolution. The default file type is SCRN, the de-
fault file creator is 8BIM, the default resource ID is 0, the default resource name

is the document's name, and the default resolution is determined by the image
type. You can changethe resolution or other parameters.

PICT Resource Options...

File Type: |SeuN|
File Creator:

Resource ID: [os
Resource Name: |Untitled-1 

Resolution:

© 1 bit/pixel
© 2 bits/pixel
© 4 bits/pixel
© 8 bits/pixel
(8 bits/pixel, System Palette
© 16 bits/pixel
@ 32 bits/pixel

PIXAR workstations are designed for high-end graphics applications, such as
work involving three-dimensional images and animation.

Whenyouselect the PIXAR option, you can specify the file type andfile creator
information for the document. The default file type is (PXR) andfile creator
(8BIM). However, you can changethesesettings. The file type must be set to PXR
if you want to use the Open commandto open the documentin the Adobe
Photoshop application.

Chapter2: Scanning, Importing, and Exporting Images 21
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To edit the file type and file creator settings, double-click in the text box of the
parameter you wantto change, then type the information. When you are ready
to save the document, click OK.

PIHAR Options...

File Type: |G
File Creator: |8BIM 

PixelPaint

The PixelPaint file format allows a documentto be openedin the PixelPaint and
PixelPaint Professional graphics applications. You can specify the imagesize
(canvas) you wantto use and whether you want the image to appearin the center
of the canvasor in the top left corner when you open the document.

PixelPaint Options...

Canvas Size:

(0512 by 512 pixels
@ 576 by 720 pixels
© 1024 by 768 pixels
© 1024 by 1024 pixels

Position on Canvas:

@ Center
© Top-Left Corner
 
 

Raw

The Raw formatis a flexible file format for transferring documents between
different applications and computerplatforms.

You can specify thefile type, file creator, and header information about the
document.

22 User Guide
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Thefile type is generally a four-character ID that identifies the file; for example,
TEXTidentifies the documentas an ASCII text document. Thefile creatoralsois

generally a four-character ID. Most Macintosh applications have a uniquefile
creator ID that is registered with the Apple Computer Developer Services group.
The headeris the numberof bytes of information that will appear at the begin-
ning of the document, before the actual image information. The value you enter
for this parameter defines the numberof zeroes that will be placed at the front of
the document. The zeroes act as place holders in the document. After you save
the document, you can useafile editing program, like Symantec Utilities for
Macintosh (SUM)II®, to replace the zeroes with header information.

You can choose to save the image in an interleaved or non-interleaved format. If
you choose the interleaved format, the color bands(red, green, and blue, for
example) are stored sequentially. The choice you make depends on the require-
ments of the application youplan to use to open the document.

Raw Options...

File Type:

File Creator: |??7??

Header: [os
Save imagein:

@ Interleaved Order
© Non-interleaved Order
 

Scitex CT

TGA

The Scitex Continuous Tone (CT) format is available for CMYK color images and
gray-scale images. Scitex computers are used for high-end image processing.
Contact Scitex to obtain utilities that will allow you to transfer a document saved
in the Scitex CT format to a Scitex system. When youselect the Scitex CT option,
the active Adobe Photoshop documentis converted directly to the Scitex format;
no dialog box appears to allow youto select options for the conversion.

The TGA formatis designed for use on systemsthat use TrueVision® video boards,
and is commonly supported by MS-DOScolor applications. The formatis also
knownas “Targa,” in reference to the TARGA® videographics board manufac-
tured by TrueVision.

You can choosethe resolution you wantif you are saving an RGB color image.

Chapter 2: Scanning, Importing, and Exporting Images
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ThunderScan

TIFF
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ThunderScan® is a hardware and software package used to scan images.

You can specify the numberofbits of information perpixel (the resolution) you
wantto save with the document.

ThunderScan Options...

Resolution:

(> 1 bit/pixel
© 4 bits/pixel
@) 5 bits/pixel 

The Tagged-Image File Format (TIFF) is used to exchange documents between
different applications and different computer platforms. You can chooseto save
Adobe Photoshop documents in a format that can be read by either Macintosh or
IBM PC computers. You can also choose to compress the documentto a smaller
size automatically by clicking the LZW Compression check box. 

TIFF Options...

Format:

© IBM PC
(@) Macintosh

CI L2W Compression 
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Saving documentsin different file formats
When yousave a document in anotherfile format, you use the pop-up menu in
the Save As dialog box. The pop-up menulists the file formats that the Adobe
Photoshop program supports. Once youselect a file format, in most cases, a
dialog box containing options for the format will appear.

To save an Adobe Photoshop document in anotherfile format:
1. Choose Save As from the File menu.

The Save As dialog box appears.

2. Type the namefor the document.

3. Use the drive and directory buttons (if necessary) to choose where you want to
store the document.

4. Position the pointer on the box nextto File Format.
5. Press down the mouse button.

A pop-up menuappearslisting the file formats the Adobe Photoshop program
supports.

File Format: Photoshop i

Amiga IFF/ILBM
CompuServe GIF
EPS
Mae P Rin?
PICT File
PICT Resource
PIHAR
PixelPaint
Raw
Scitex CT
TGA
ThunderScan
TIFF

 
6. Holding down the mouse button, drag to highlight the format in which you

wantto save the active document. Release the mouse button.

7. Click Save.

The options dialog box for the selected file format appears.

8. Select the options you wantby clicking the appropriate check box or radio
button.

9. When you are finished selecting the parameters you want, click OK.

When you save an Adobe Photoshop documentin a different file format, a
unique document iconidentifying the selected file format is used for the
document.

Chapter 2: Scanning, Importing, and Exporting Images=25
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Using plug-in modules to import and export images

User Guide

Plug-in modules are software programs developed by third-party vendors in con-
junction with Adobe Systems to extend the standard Adobe Photoshop program.
The program modulesare distributed on floppy disks and are represented as
icons,like application and utility programs. The instructions for using the
program are shipped with the module.

Modulesare available that allow you either to import (acquire) images from

devices such as scanners, or export images to devices such as printers that are not
supported by the Apple® printer drivers. Acquire modules allow you to control a
scanner or video frame capture system, or to decompress a document. Export
modules let you save an Adobe Photoshop document ina file format not support-
ed by the standard Adobe Photoshopprogram,orlet you export images to devices
such as printers that are unavailable through the Chooser.

To use an acquire or export module, you mustinstall a copy of the module in the
folder containing yourpreferencesfile. Once installed, the module will be active
under the File menu when youselect either the Acquire or Export command,de-
pending on the type of module youare using.For detailed instructions on using
plug-in modules with the Adobe Photoshop program,refer to the appropriate
documentation included with the third-party software disk.
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Section 2: Using the Adobe Photoshop Toolbox
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 The designer scannedin three photosof sand,a fish, and an anemone as 35mmslides,
and combined theminthisillustration. She increased overall brightness in the images
using the adjust levels controls to bring out as much detail in the shadow areas as
possible, She blurred the sand and screenedit to create a backgroundtexture, then
rotated and croppedthe plant image tofit within the foreground area. Using a separate
file, the designer selected the fish and rotatedits position, then copied and pasted the
fish into the plant image.
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Chapter 3: Managing the Toolbox

The Adobe Photoshoptools in the toolbox allow you to paint, select, edit, and
change your view of images.All of the tools are represented by icons thatreflect
the name of the tool andits function, The toolboxis a floating palette. This
meansthat you can moveit around the screen andit will float above the image,
allowing youto paint beneath it. You can move the toolbox to a more convenient
location, or hide it to make more room onthescreen.

This chapter gives a brief overview of the tools in the toolbox andtells you how
to control the toolbox.

To select the tool you wantto use, click the tool in the toolbox.

File Edit Mode image Selec? Windowah
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Thetool is highlighted. Also, the arrow pointer changes into the pointer
(cursor shape) appropriate for the selected tool when you position it in the active
window.
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To use the tool on the image:

. Position the tool pointer on the image where you want to usethe tool.

. Press down the mouse button.

. Drag the pointer across the image.mhWwWNM

. Release the mouse button when youhavefinished using the tool.

To movethe toolbox, position the pointer on the gray bar at the top of the tool-
box.

Hold down the mouse button. Drag until the toolbox is where you wantit, then
release the mouse button.

File Edit Moe imege Selec? Window

 
 

To hide the toolbox:

1. Press the Tab key to hide the toolbox.

2. Press the Tab key again to redisplay the toolbox.

28 User Guide
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Tool overview

Belowis a brief description ofall of the tools in the toolbox. The tools are
arranged in the toolbox according to their functions. The categories for tools are
selection tools, viewing tools, text tools, fill tools, painting tools, editing tools,
and miscellaneous tools. The toolbox also contains color and screen mode

controls.

Selection tools

ema]]ens' ’ 1 1ta bl

 

 

The lasso tool

You can use the lasso tool to define any arbitrary selection area. The lasso tool
operates like a freehandtool, and lets you trace the outline ofa selection.

The rectangular andelliptical marquee tools

The rectangular marquee makes rectangular and squareselections, and theellip-
tical marquee makeselliptical and roundselections. The options available for
both tools are very similar. For example, you can specify a certain fixed size, as
well as a height-to-width ratio, for each marqueetool.

The magic wandtool

The magic wandis a versatile selection tool that allows you to select images based
upon the color similarities of adjacent pixels. You can select part of an image
without tracing it, and you can also choose how extensive you want theselection
to be. For example, you can choose either to select just the dark hair of a person
in an image, or the person's lighter clothing as well.

The eyedroppertool

The eyedroppertool selects the current foreground and backgroundcolors from
colors in an image. The foregroundcoloris used by the paintingtools.

Viewing tools

The grabbertool

The grabbertool lets you scroll through an imagethatis too largeto fit in the
active window. You can scroll in any direction without using thescroll bars on
the window by temporarily switching from oneof the painting tools to the
grabbertool.

The zoom tool

The zoom tool allows you to zoom in on an imageto perform close, detailed work
on an image, or zoom outto get an overall view.

Chapter 3: Managing the Toolbox
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The cross hair pointer

The cross hair pointer works in conjunction with the tools to give greater preci-
sion. Whenused with a painting, editing, or selection tool on an image, the cross
hair pointer allows you great accuracy by focusing the “hot spot” of the cross
hairs (the dot in the middle of the cross hairs) on the areas where youare using
the tool. To use the cross hair pointer, press the Caps Lock key.

 
Release the Caps Lock key to resume using the tool’s normal pointer.

Text tools

Thetype tool

The type tool enters pixel-based type on an image. You can select a number of
options for the type you enter, including the font and pointsize for type, and
select style options such as underlining anditalics.

Fill tools

The paint buckettool

Thepaint bucket toolfills areas with the foreground color. The paint bucket tool
fills pixels that are similar in color, in a similar way to the magic wand, Using the
paint bucket tool, you canfill a discrete part of an image, such as a chair or an
animal, simply byclicking onit.

The blendtool
 

The blend tool creates a gradientfill that displays a gradual transition from the
foreground color to the backgroundcolor.

30 User Guide
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Painting tools

The pencil tool

The pencil tool creates either freehand orstraight, hard-edged lines. The pencil
tool includes an auto-erase option that allows you to change pixels that are the
foreground color to the backgroundcolor.

The line tool

Theline tool creates straight lines. You can specify the thickness of lines (line
weight) you create, and create lines with arrowheads. Lines created using the line
tool are anti-aliased. Anti-aliasing smoothes out the edgesof lines so they do not
appear jagged.

The paint brush tool

The paint brush tool paints the foreground color into the image. The marksleft
by the paint brush tool are more diffused than the pencil tool’s marks. The paint
brush tool paints marks with soft edges.

The airbrush tool

Theairbrush tool lays down a diffused spray of paint on an image. You can
control the pressure of the paint and therate it is sprayed on the image.

The rubber stamp tool

The rubber stamp tool picks up a sample of an entire image, and places an exact
copy or a modified version of the selection elsewhere in the same imageor in
some other image. The rubber stamp options control the way a selected image,
pattern, or texture is painted onto the image. The Revert option allows you to
restore part of an imageto the last version you saved.

Editing tools

The cropping tool

The cropping tool selects part of an image and discards the unselected portion.
You define the cropping area by dragging a rectangular selection marquee around
the image, or by specifying the size of the selection area you want, and placing
the selection marquee aroundtheselection.

The eraser tool

The eraser too] changes pixels to the background color. This has the effect of
“erasing” the pixels. You can change just the pixels you drag through or the
entire image. You also can use the eraser to restore part of the imageto thelast
version you saved.

Chapter 3: Managing the Toolbox
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The smudgetool

The smudge tool simulates the effect of a finger dragging through wet paint.
When you use the smudge tool, the colors of the pixels you drag through are
gradually dispersed until the smudge fades out completely.

The blur tool

Theblur tool blurs part of an image. The blur tool producesa less focused image
by diffusing colors in the pixels to which the toolis applied.

The sharpen tool

The sharpen tool sharpenspart of an image. As you drag through part of an
image, the sharpen tool increases the contrast between adjacent pixels. This
results in a sharper, more focused image.

Color controls

User Guide

Foreground colorindicator

The foreground color indicator on the toolbox displays the current foreground
color. Manyofthe painting tools paint with the foreground color. By clicking the

foregroundcolor indicator, you can display the Color Picker dialog box, which
you can use to select a new foregroundcolor.

Background color indicator

The backgroundcolor indicator on the toolbox displays the current background
color, The background coloris used as the background in new documents and
appears in place of parts of the image you cutor delete. By clicking the back-
ground color indicator, you can display the Color Picker dialog box, which you
can use to select a new backgroundcolor.
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Screen modecontrols

The screen mode buttons on the bottom of the toolbox control the window

display. The currently selected screen mode option is underlined in the toolbox.
These optionsallow youto display the image inside the document window with
the menu barvisible; at full-screen size without the document window and the
menubarvisible; or, at full-screen size without either the document window or
the menubar.

To display the image inside the document windowwith the menubar(thisis the
default screen mode),click the left screen mode button on the toolbox.

 
To display the imageat full-screen size without the menubar, click the right
screen mode button on the toolbox.

To display the imageat full-screen size with the menubar,click the center screen
mode button on the toolbox.

Chapter 3: Managing the Toolbox
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Chapter 4: Controlling the Artwork and Screen Display

The Adobe Photoshop program provides various ways to change the view of an
image. In addition to the scroll controls and other window controls, you can use
the grabbertoolto scroll in two directions simultaneously. You can use the zoom
tool and Zoom commandsto obtain a magnified or more distant view of an
image.

For information about using the standard Macintosh windowcontrols, like the
scroll bars, resize, and zoom boxes, see your Macintosh user guide.

Zoomingin and out from an image
The zoom tool in the toolbox and the Zoom commandsin the Window menu

allow you to zoom in on an imagefor a magnified view, or zoom outfor an over-
all perspective. The 1:1 view displays the image based uponthescreen resolution

and the imageresolution, not the actual height and width dimensionsof the fl
image. Because the Adobe Photoshop program displays images at a screen resolu-
tion of 72 pixels per inch, images with greater resolution will appear enlarged on-
screen. For example, when displayed at a 1:1 view, an image with a resolution of
200 pixels per inch will appearlarger than its actual size because the screen can
only display 72 pixels per inch. You can edit an image at any magnification.

The zoom tool changes by a factor of two (2x) each time you click the mouse
button (2x, 4x, 8x, and 16x). Thetitle bar always displays the current zoom level,
for example, 2:1 fora magnification by a factor of two.A plussign (+) in the zoom
pointer indicates that you are ready to zoom in, while a minussign (-) indicates
you are ready to zoom out. The maximum zoomlevels for an image is +16x and
-16x.

The Zoom In and Zoom Out commands (and their Command-key equivalents)
allow you to magnify or shrink a view, In addition, you can use the Zoom Factor
commandto zoom in or zoom outto a specified zoomlevel.

To use the zoom tool to zoom in on an image:
1. Click the zoom tool in the toolbox.

2. Position the zoom pointer on the part of the image you want to magnify.

Notice that a plus sign (+) appears in the zoom pointer.
3. Click the mouse button.

The image is magnified by a factor of two.
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. Continue clicking the mouse button until the view you wantis displayed, or

until you reach the maximum zoomlevel.

 

 
To zoom out from an image:
Click the zoom tool in the toolbox.

Position the zoom pointer on the image.

Press down the Option key.

Holding down the Option key, click the mouse button.

Continueclicking the mouse button until the view you wantis displayed, or
until you reach the minimum zoom level.

Release the Option key.

Note: You canquickly return to the 1:1 view ofan image by double-clicking the zoom
tool. Also, you can activate the zoom tool from the keyboard by holding downthe
Command key and the spacebar, placing the pointer inside the active window, and
clicking the mouse button, This activates the zoom-in mode. To activate the zoom-
out mode, hold down the Option key and the space bar.

Using the Zoom commands

User Guide

The Zoom commandsallow you to change your view of an image similar to the
zoom tool. The major advantage of using the Zoom In and Zoom Out commands
over the zoom toolis that you can implement them directly from the keyboard.
The disadvantage to using the Zoom commandsis that you can’t specify the area
you want to magnify as you can with the zoom tool. When you use the Zoom In
command, the Adobe Photoshop program magnifies the area in the
center of the active window.

The Zoom In command magnifies the view of the image by a factor of 1 (1x, 2x,
3x, and so on) each time you chooseit until the maximum zoom level of +16 is
attained; the Zoom Out command zoomsoutbya factor of 1 each time you
choose it until the maximum zoom level of -16 is attained.
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To use the Zoom In command, choose Zoom In from the Window menu,or type
Command + (plus sign).

To use the Zoom Out command, choose Zoom In from the Window menu,or

type Command- (minussign).

Specifying a zoom factor

You can immediately magnify or reduce your view when you are working on a
large, high-resolution image by using the Zoom Factor command. The Zoom
Factor commandspecifies a magnification or reduction factor of a view. When
you specify a zoom factor, the Adobe Photoshop program immediately displays
the specified zoom level.

To use the Zoom Factor command:

1. Choose Zoom Factor from the Window menu.

The Zoom Factor dialog box appears.

2oom Factor...

Factor:

© Magnification
@ Reduction 

2. Click Magnification to zoom in; click Reduction to zoom out.

3. Type a value from 1 to 16 for the zoom factor you want.
4. Click OK.

The specified zoom level is displayed on-screen.

Scrolling in two directions

When you are working on an image that extends beyond the borders of the
document window,you can use the grabbertool to scroll in two directions
simultaneously.

To use the grabbertool to scroll across an image:

1. Click the grabber tool in the toolbox.

2. Position the grabber pointer on the image.
3. Press down the mouse button.

Chapter 4: Controlling the Artwork and Screen Display—37
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4. Holding down the mousebutton, drag in the direction opposite the part of the
image you wantto display. For example, to display the lower -right corner of the
image, drag toward the upperleft corner of the image.

5. Release the mouse button when you havedisplayed the part of the image you
want.

Note: Double-click the grabber tool to display the entire image in the largest size
possible on your screen.

Using rulers

User Guide

 

You can display rulers along the top andleft side of the active window to make
measurements on an image. The rulers measure sizes in inches, centimeters,
points, or picas. You can choose the units of measurementfor each ruler separate-
ly. The rulers also allow you to specify columns to simulate a page layout.

When you movea pointer inside the window, markers appear on therulers to
showthe pointer’s position relative to the zero origins of the rulers. The markers
reflect the position of the pointer’s “hot spot” in the window.

The ruler origin is tied to the document, not the window.As you scroll and zoom
around the document, the rulers adjust accordingly.

To display the rulers, choose Show Rulers from the Window menu.To hide the
rulers, choose Hide Rulers from the Window menu.

Whenyou choose Show Rulers, a horizontal and vertical ruler appear along the
top andleft side of the active window.

You can change therulers’ zero origins. This allows you to make measurements
from a specific point on an image.

To changethe rulers’ zero origins:

. Position the pointer in the upperleft corner of the window,directly beneath the
close box.

2. Press down the mouse button. 

Koala (1:1)
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3. Holding down the mouse button, drag onto the image.

A set of crosshairs appears.

4. Drag until the center of the cross hairs is on the point you wantto use as the zero

origin for the rulers.
= 5. Release the mouse button.

= Specifying units of measurement

By default, the Adobe Photoshop program uses inchesas the units of measure in
documents. However, you can use centimeters, points, and picas instead. You can
use different units of measurementfor each ruler. For example, you could use
points for the horizontal ruler and picas for the vertical ruler.

Thesize units you specify for the rulers are used in dialog boxes that allow you to
specify size units. For example, the size unit choices for the horizontal ruler are
used in the Resample dialog box in the Image menufor the Width parameter, and
the units for the vertical ruler are used for the Height parameter.

- To select the units of measurement you wantfor a ruler:

1. Choose Page Setup from the File menu.

The Page Setup dialog box appears. 

LaserWriter Page Setup

_ Paper: @ US Letter ©A4 Letter

aegeSe

OUS Legal ©B5 Letter OLtabioia|

a Reauce or (ona) Printer Effects:&] Font Substitution?

= Orientation [EJ Text Smoothing?
—] Graphics Smoothing?

— () Faster Bitmap Printing?

_ (J Crop Marks CJ Emulsion Down

oO Calibration Bars

Size/Rulers... () Registration Marks
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2. Click Size/Rulers.

The Image Size/Ruler Units dialog box appears.

Image Size/Ruler Units...

 
The two boxesbeside the Width and Height text boxes are used to access pop-up
menus. You use the Width pop-up menu to choosethe units for the horizontal
ruler; you use the Height pop-up menuto choose the units for the vertical ruler.

To choose the units of measurement you wantfor a ruler:

1. Position the pointer on the Width or Height box next to the ruler you want.
2. Press down the mouse button.

A pop-up menulisting the available units of measure appears.

Image Size/Ruler Units...

Width: /(inches)
. (cm)

Height:|7.111 (points)
Resolution: (picas) 

3. Holding down the mouse button, drag to highlight the units you want.

4. Whenthe desired units appear in the box, release the mouse button.
5. Click OK.
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Specifying a columnsize

You can use columns as a way to simulate page layouts in the Adobe Photoshop
program. A columncan be anysize you specify. A column includes a specified
width and gutter size. You can specify a particular column andguttersize to

matchthe page layout of the page that will hold the final image. This allows you
to make sure that the imagewill fit in your layout if you use the cropping tool or
the Resample command in the Image menuto resize an image, or use the Size/
Rulers option in the Page Setup dialog box to print out an imageat a certain size.
You can only use columnsfor horizontal measurements.

As an example, you can specify a size of 1 inch for columns, and .25 for the
gutter, then specify 2 columnsfor the width parameter in the Cropping Tool
Options dialog box and crop an image. The width of the cropped image will be
2.25 inches, which represents a width of 2 columnsand1 gutter size between the
columns.

The Preferences dialog box in the Edit menu allows you to specify size units for
the columnwidth and gutter, Pop-up menuslet you choosethesize units, either
inches, centimeters (cm), points, or picas.

To specify column dimensions:
1. Choose Preferences from the Edit menu.

The Preferences dialog box appears.  

Preferences...

Display: Separation Setup...
(] Colored separations

(_] Use system palette Column Size:

4] Use DirectSetEntries Width:

Clipboard Export: ; =© Disabled co
©)1bit/pixel
© 2 bits/pixel
© 4 bits/pixel © Nearest Neighbor
© 8 bits/pixel oO Bilinear
© 8 bits/pixel, System Palette @ Bicubic
© 16 bits/pixel
© 32 bits/pixel

Interpolation Method: 
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. Use the Width and Gutter pop-up menusto choose the units of measure you
wantfor the column width andgutter.

. Enter the width you wantfor the column.

. Press the Tab key or double-click the Gutter text box.

. Enter the size you want for the gutter.

. Click OK.
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Chapter 5: Using the Painting Tools

This chapter describes how to use the painting tools. The painting tools in the
toolbox allow you to add paint to a selected image or area. Painting changes the
colors of pixels in an image. The painting tools include the pencil tool, the line
tool, the paint brush tool, the airbrush tool, and the rubber stamptool.

Each tool includes several options, which are accessed via a dialog box that
appears when you double-click the tool in the toolbox. Some options common
to all of the painting tools include the ability to paint or edit along a straight line,
and to use color modesto paintor edit areas that are only lighter or darker than
the foreground color. Chapter 7, “Painting and Editing Tool Options,” discusses
the options commontoseveraltools.

If you are using a painting tool on an imagethatis larger than the window, you
can scroll through the image by switching temporarily to the grabber tool. This
allows you to scroll in any direction without using the scroll controls.

Unless otherwise noted, the painting tools by default all paint with the fore-
groundcolor. The foregroundcoloris displayed in the center square within the
rectangle at the bottom of the toolbox. The backgroundcolor, whichis displayed
in the rectangle surrounding the square, is used for making blends and erasing.
You can change the foreground and backgroundcolor using the eyedroppertool.
“Using the eyedropper tool” in Chapter 11, “Selecting Colors,” contains more in-
formation aboutselecting colors using the eyedroppertool.

To change the foreground color to another color in an image:

1. Click the eyedropper tool in the toolbox.

. Position the eyedropper pointer on the color you wantto use as the foreground
color.

3. Click the mouse button.
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To scroll across an image while using a painting tool:

1. Hold downthespacebar.

2, Position the pointer on the image.

The pointer changes into the grabber.
3. Press down the mouse button.

4, Drag in the direction you want the image to move. For example, if you want to
view the left of the image, drag right to make the image moveright.

 
5. Release the mouse button.

6. Release the space bar to resumepainting.

Using the pencil tool

Thepencil tool creates either freehandorstraightlines. Thelines are hard-edged.
The pencil tool’s Auto Erase option changes pixels that display the current fore-
groundcolor to the background color. When youselect the Auto Erase option,
position the pointer on a pixel that is the same color as the foregroundcolor, and
drag through the image. The pencil too] changesall pixels.

To paint with the pencil tool:

1, Click the pencil tool in the toolbox.

2. Position the pointer where you want tostart painting.

3. Holding down the mousebutton, drag to painta line.

4, When you havefinished painting, release the mouse button.

a
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To drawastraight line with the pencil tool:

. Click the pencil tool in the toolbox.

. Press the Shift key, and click the mouse button at the beginning and end points
of the line you wish to draw.

. Release the Shift key.

To choose the Auto Erase option for the pencil tool:

. Double-click or Option-click the pencil tool in the toolbox.

The Pencil Options dialog box appears.

Pencil Options...

Spacing: fi|Made:
@ Normal

Opacity: [100] % © Color Only
© Darken Only

CL Auto Erase © Lighten Only

ea 
. Click Auto Erase.

The Auto Erase box is checked, indicating the Auto Erase optionis active.
. Click OK.

. Position the pointer on the area you wantto paint.

Holding down the mouse button, drag through the image.

Whenyou havefinished painting, release the mouse button.

Chapter5: Using the Painting Tools 45
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Using theline tool
Theline tool creates straight lines on an image. Line tool options allow you to
specify the width of lines (in pixels) and create lines with arrowheads. Also, you
can constrain the line tool to create horizontal or vertical lines, or lines con-

strained at 45-degree angles. You can choose to have the arrowheads appearat
the start of the line, at the end, or at both ends.

Unlike the marks created using the penciltool, the lines you create using the line
tool are anti-aliased. The smooth, anti-aliased edges of the lines prevent the
jagged edges that commonly appear in paint applications.

To create a line using the line tool:
. Click the line tool in the toolbox.

2. Position the line tool pointer where you wantthelinetostart.

. Holding down the mouse button, drag in the direction you want to project the
line.

. Whenthe line is the desired length, release the mouse button.

 
To create a constrained, straight line using the line tool:

1. Click the line tool in the toolbox.

. Position the line tool pointer where you wantthelineto start.

3. Hold downtheShift key to constrain the line in 45-degree increments as you

4.
drag the mouse.

Whentheline is the length you want, release the mouse button.

Specifying line weights and arrowheads

User Guide

Before you create lines, you must choose the line weight and arrowhead options
you want.

You can control the shape of the arrowhead byspecifying the height and width
(in pixels) and the degree of concavity (as a percentage value). The concavity pa-
rameter defines the amount of curvature on the widest part of the arrowhead
whereit meets the line.
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To choose optionsfor the line tool:

1. Double-click or Option-click the line tool in the toolbox.

wNM

WwRe
oe

The Line Tool Options dialog box appears.

Line Tool Options...

Width: (a (pixels)
Arrow Heads:

Cat Start Dat end

width: [9|(pixets)
Length: (pixels)

Concavity:[o|‘te
 

. Type the width you wantforlines (in pixels).

. Specify where you want arrowheadsto appear by clicking the At Start option to
create lines with arrowheadsat the starting points; the At End option to create
lines with arrowheadsat the ending points; or both optionsto create lines with
arrowhead on both ends.

Whentheoptionis checked, arrowheadswill appear on the specified end or ends
of lines you create with the line tool.

To specify the attributes for arrowheads with theline tool:

. Double-click in the Width text box.

. Enter a value from 5 to 99 for the arrowhead width.

. Press the Tab key or double-click in the Length text box, and enter a value from
7 to 99 for the arrowhead length.

. Press the Tab key or double-click in the Concavity text box, enter a value from 0
to 50 for the concavity of the arrowhead.
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Concavity value: 0%

Concavity value: 25%

Concavity value: 509%
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Whenyouhavefinished choosing optionsfor the line tool, click OK.

Using the paint brush tool
The paint brush tool paints the foreground color into an image. The paint brush
tool, unlike the pencil tool, applies the paint with soft edges. The paint brush tool
worksonall types of images, except bitmapped and indexed color images.

paint brush tool

pencil tool 
To paint with the paint brush tool:

1. Click the paint brush tool in the toolbox.

2. Position the paint brush pointer where you wantto begin painting.

3. Holding down the mouse button, drag to lay downa brushstroke.

4. To end the brush stroke, release the mouse button.

nd

Using the airbrushtool
Theairbrush tool lays down a diffused spray of paint on an image. The tool works
only on gray-scale and RGB images. You can specify the rate at which theairbrush
tool deposits paint on the image. The higher the value you specify, the faster
paint is deposited on the image. The Pressure parametercontrols therate of paint
flow.

48 User Guide
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To paint with the airbrush tool:

. Click the airbrush tool in the toolbox.

. Position the pointer where you want to begin spraying paint.

. Holding down the mouse button, drag to spray-paint the image.

. When you have finished airbrushing, release the mouse button.

L

To specify the pressure for the airbrush tool:

1. Double-click or Option-click the airbrush tool in the toolbox.

The Airbrush Options dialog box appears. 

Airbrush Options...

_ + © @€ @@ @

feje@-uc8G
| | Custom

Spacing: Mode:

() Normal
© Color Only
© Darken Only
© Lighten Only

Fade-out:

Repeat Rate:

Pressure

 
 

2. Enter a value from 1 to 100 in the Pressure text box.

3. Click OK.

Chapter 5: Using the Painting Tools
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Using the rubber stamptool
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The rubber stamptooldiffers from other painting tools becauseit allows you to
paint more than just a color onto an image. You can use the rubber stamptool to
pick up a sample of an image, pattern, or texture and place an exact copy(called
a “clone”) or a modified version of what you picked up on the same image or
some other image.

The rubber stamptool includes options that control how you can painta pattern,
texture, or part of an image onto the image. The options include the aligned and
non-aligned Clone options, the aligned and non-aligned Pattern options, and the
Texture, Impressionist, and Revert options. The default rubber stamp option,
whichis the aligned Clone option, allows you to pick up an image, and paint in
an exact duplicate of that image.

To use the rubber stamp tool with its default options:

. Click the rubber stamp tool in the toolbox.

. Position the rubber stamp pointer on thepart of the image you wantto use.

Hold downthe Option key.

. Click the mouse button to take a sample of the image.

. Release the Option key.

To paint with the rubber stamp tool using the selected image:

. Position the rubber stamp pointer where you wantto begin painting.
Hold down the mouse button.

. Drag to paint in the selected image.

. Release the mouse button.

Rubber stamptool options

User Guide

The Clone options allow you to choose part of an image and paint an exact copy
of it elsewhere. The Revert option allows you to restore part of an image to the
way it appeared the last time you saved the image. The Pattern options allow you
to paint the current pattern on an image. The Texture option lets you select part
of an image andpaint a modified version of that part elsewhere. The Impression-
ist option lets you create an impressionistic effect on an image. The selected op-
tion is used throughout your Adobe Photoshopsession until you choose another
option.
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To select the rubber stamp tool option you wantto use:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

Rubber Stamp Options...

@ Clone (aligned)
© Clone (non-aligned)
© Revert
© Texture
© Pattern (aligned)
© Pattern (non-aligned)
© Impressionist

 Opacity: (oom) %

@ Normal
© Color Only
© Darken Only
© Lighten Only

ea)
2. Click the nameof the rubber stamp tool option you want.

The radio button beside the selected option is highlighted.
3. Click OK.

75
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The Clone option

User Guide

The Clone option for the rubber stamptool allows you to paint an exact copy of
a selected image. The Clone option lets you take a sample of the entire image,
then paint the sampled image,starting at the point from which you took the sam-
ple. Each stroke of the tool paints more of the image you sampled.

To select the part of the image you wantto clone, you select the rubber stamp
tool and Option-click. When you position the pointer on the image and drag, a
marker mirroring the pointer’s movement appears near the point where you
Option-clicked, This marker identifies the part of the image you are currently
painting.

Whenyou begin painting, what appearsfirst is the part of the image that was
under the rubber stamp pointer when you picked up your sample. As you stroke
through a wider area, more of the imageis reproduced.

 
Two Clone options, aligned and non-aligned, determine whatpart of the
sampled image appears first when you release the mouse button andstart paint-
ing elsewhere on the image with the tool. The aligned option paints the sampled
image continuously, as if you continued to drag the rubber stamptool to a new
position. The non-aligned option always paints the sampled image from the
point where youstarted taking the sample.

Whenthe non-aligned optionis active, each time youstart painting in a different
area, the sampled image is painted in starting from the point youoriginally
Option-clicked on the image. This optionis useful for painting in multiple copies
of part of an image (such as a daffodil or tulip) on manydifferent parts of an
image.

The aligned Clone optionis useful in situations where you wantto use different
brushes to paint an image. You could select a large brush and paint the majority
of the image, then select a small brush to paint the detailed areas. The aligned
clone option ensures that the two different brush strokes (one with the large
brush, the other with the small brush) create an imagethatlines up correctly. You
could also use this option to paint two halves of an image, with onehalf on either
side of another part of an image.
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As an example, suppose you are working on an image that contains flowers and
you wantto paint an imageofa tulip behinda leaf. To do this, you select the
aligned Clone option from the Rubber Stamp Option dialog box, and Option-
click on the image of the tulip. To paint the tulip behind the leaf, you position
the tool on the left side of the leaf and paint theleft side of the tulip. Then you
release the mouse button, position the tool on therightside of the leaf and paint
the right side of the leaf. This gives the effect of the tulip appearing behind the
leaf.

To use the non-aligned Clone option with the rubber stamp tool:

1. Double-click or Option-click the rubber stamp tool in the toolbox,

The Rubber Stamp Options dialog box appears.

2. Select the Clone (non-aligned) option, Click OK,

3. Position the pointer where you want to take a sample from the image, and Op-
tion-click.

4. Position the pointer where you wantto paint the cloned image.

5. Holding down the mouse button, drag to paint the image.

6. When you havefinished painting the cloned image, release the mouse button.
fi . To paint in the cloned imagestarting again from the point you sampled the

image, reposition the pointer, hold down the mouse button, and drag to paint
the image.

 
First application of paint Second application of paint
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To use the aligned Clone option with the rubber stamptool:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

2, Select the Clone (aligned) option. Click OK.

3. Position the pointer where you want to take a sample from the image, and
Option-click.

4, Position the pointer where you wantto paint the cloned image.

5. Holding down the mouse button, drag to paint the image.

6. When you havefinished painting in part of the cloned image, release the mouse
button,

7. Position the pointer where you want to paint more of the cloned image.

8. Holding down the mouse button, drag to paint the image.

9, Continue repositioning the pointer and painting in the various parts of the
cloned image until you have finished painting, then select a different tool.

In the illustration below of the second application of paint, notice that the
marker showspart of the original, sampled image you are currently painting.

 
 

First application of paint Second application of paint
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The Revert option

The Revert option for the rubber stamp tool restores an area on the image to the
wayit appearedthelast time you saved the document. This option allows you to

experimentfreely with an image, then selectively restore a portion of the image.
The Revert optionis similar to the eraser tool’s magic eraser mode, which restores
part of an image toits state when youlast saved it. The difference is that with the
Revert option, you can specify a brush shape for the rubber stamptool, and the
brushis soft-edged rather than hard-edged.

Whenyou use the Revert option, the Adobe Photoshop program reads in the last
saved version of the image from disk, and restores the portions of the image
through which you drag the rubber stamp tool. When you begin painting using
this option, it may take a few momentsfor the tool to start working while the
imageis read in from disk.

To use the Revert option with the rubber stamptool:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.
No . Select the Revert option from the Rubber Stamp Options dialog box. Click OK.
w . Position the rubber stamp pointer where you wantto begin restoring the image.
oe . Holding down the mouse button, drag until you have restored the desired

portion of the image.
5. Release the mouse button.

   
Modified but unsaved version of image The Revert option restores the last saved

version of the area through which you drag
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The Texture option

User Guide

The Texture option for the rubber stamp tool paints a modified version of a
selected texture. You select the Texture option, then select a texture on an image.
Whenyoupaint the image, the pixels in the texture are randomly distributed to
prevent a repeating pattern from appearing. If you make several strokes through
the samearea, the pattern will be different each time.

To use the Texture option with the rubber stamptool:

. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

. Select the Texture option from the Rubber Stamp Optionsdialog box. Click OK.

3. Position the pointer on the texture in the image you want, and Option-click.

 
Texture selected

4. Position the pointer where you wantto paint the texture.

. Holding down the mouse button, drag to paint the modified texture.

6. When you havefinished painting, release the mouse button.

 
Image with texture added
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The Pattern options

TwoPattern options allow you to paint a pattern onto your image: the aligned
Pattern option and the non-aligned Pattern option. Both Pattern optionslet you
select a pattern, then use the rubber stamp tool to paint using the selected pat-
tern. The aligned option repeats the pattern as contiguous, uniform tiles; even
whenyoustroke several times over the samearea, the pattern is repeated. The
non-aligned option centers the pattern around the center of the rubber stamp
pointer without maintaining the entire pattern for each stroke.

To use the aligned Pattern option with the rubber stamptool:

1. Click the rectangular marquee tool in the toolbox.

2. While holding down the mousebutton, drag until you haveselected the pattern
you wantto use; release the mouse button.

i
Li
\!
;=) 

3. Choose Define Pattern from the Edit menu.

4. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

5. Select the Pattern (aligned) option from the Rubber Stamp Options dialog box.
Click OK.
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6. Position the rubber stamp pointer where you wantto begin painting.

7. Holding down the mouse button,drag to paint in the pattern

8. When you havefinished painting, release the mouse button.

 
Second application of paint 

Aligned pattern

To use the non-aligned Pattern option with the rubber stamptool:

1. Click the rectangular marquee tool in the toolbox.

2. Holding down the mouse button, drag until you have selected the pattern you
wantto use.

3. When you haveselected your pattern, release the mouse button.
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i . Choose Define Pattern from the Edit menu.

5. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

6. Select the Pattern (non-aligned) option from the Rubber Stamp Optionsdialog
box. Click OK.

“J . Position the rubber stamp pointer where you wantto begin painting.
oo . Holding down the mouse button, drag to paint in the pattern.
so . When youhavefinished painting, release the mouse button.

 
First application of paint Second application of paint

va 
The Impressionist option

The Impressionist option for the rubber stamp tool creates textured designs based
on thelast saved version of a document. When you use the Impressionist mode,
the Adobe Photoshop program reads in the colors from the last saved version of
the area you drag through, and smears together the colors of the pixels beneath
the brush to create an “impressionistic” effect. lt may take a few momentsfor the
rubber stamp tool to start working while the imageis read in from disk.
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To use the Impressionist option with the rubber stamp tool:

. Double-click or Option-click the rubber stamptool in the toolbox.

The Rubber Stamp Optionsdialog box appears.

. Select the Impressionist option from the Rubber Stamp Options dialog box. Click
OK.

3. Position the rubber stamp pointer where you want to begin painting.

4. While holding down the mouse button, drag to paint the image.

§. Whenyouhavefinished painting, release the mouse button.
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Chapter 6: Using the Editing Tools

oopfsa

The Adobe Photoshopediting tools let you erase, smudge, blur, and sharpen
specific parts of an image. Theeraser tool changes pixels to the backgroundcolor.
The smudgetool simulates the effect of dragging a finger through wet paint. The
blur tool diffuses the colors of pixels you drag the tool through,to create a less-
focused image. The sharpen tool increases the contrast between adjacent pixels

to sharpen an image.

All of the editing tools include options. With the exceptionof the eraser tool, you
can double-click a given editing tool to display the tool’s options. The options
include the ability to constrain an editing tool to a straight line, and edit only
pixels that are lighter or darker than the foreground color. Chapter 7, “Painting
and Editing Tool Options,” describes the options commonto all the editing tools.

You can also use the Blur and Sharpen commandsin the Image menuto blur or
sharpenselected parts of an image or the entire image at once. The advantage of
using the blur and sharpentoolsis that they allow you to concentrate the blur or
sharpen effect on a small area.

For more information about the Blur and Sharpen commands,see the sections
“Using filters to soften an image” and “Usingfilters to sharpen an image” in
Chapter 17, “Using Filters to Modify Images.”

To use an editing tool:

Click the desired editing tool in the toolbox.

Position the tool pointer where you want to edit the image.
Hold down the mouse button.

Drag across the image.

Release the mouse button when you havefinished editing.

Editing with the eraser tool
The eraser tool changes pixels to the backgroundcolor. This has the effect of
“erasing” the pixels. You can erase just the pixels you drag through, or you can
erase the entire image by double-clicking on the eraser tool in the toolbox. You
can also use the eraser tool to restore part of the image to the last version you
saved, using the magic eraser mode. You can undo yourlast erasure by immedi-
ately choosing the Undo commandfrom the Edit menu.

You canuse the eraser tool in the magic eraser modeto restore part of an
image to its state when youlast saved the document. Unlike the Revert command
in the File menu, whichrestores the entire image to its previous state, the eraser
allows you to define specific parts of the image you want to restore. This opera-
tion is similar to using the Revert option for the rubber stamp tool. However, the
Revert option for the rubber stamptool gives you more control over the area that
is restored because youcan specify the brush size for the tool.
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The eraser tool always erases or restores the area beneath the tool pointer. The
eraser always appears the samesize, regardless of the magnification level. Thus,
the size of the erased area depends on the magnification level of your view. For
example, at a 1:1 view, the eraser pointer covers a 16-pixel-by-16-pixel area,
whereas at a 16:1 magnification, it covers only a 1-pixel-by-1-pixel area.

To erase part of an image by changing pixels to the backgroundcolor:
. Click the eraser tool in the toolbox.

2. Position the eraser pointer where you wantto start erasing the image.

. Holding down the mouse button, drag through the part of the image you want
to erase.

. When you have finished erasing the image, release the mouse button.

 
To erase the entire image at once, double-click or Option-click the eraser tool in
the toolbox.

 
To use the eraser in the magic eraser modeto restore part of an image:

. Click the eraser tool in the toolbox.

. Position the eraser pointer where you want to begin restoring the image.

3. Hold down Option key, then the mouse button.

User Guide

The pointer turns into the magic eraser pointer.
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4, Drag over the part of the image you wanttorestore.

= The area you drag throughis restored to the way it looked when youlast saved
the document.

 
Current, unsaved version of image 

Magic eraser restoring part of imageto last
saved version

5. When you have finished restoring the part of the image you want, release the
mouse button and the Option key.

Z Using the smudgetool
The smudgetool allows you to simulate the effect of dragging a finger through
wet paint. The smudge tool works on all types of images except bitmapped and
indexed color images. When you use the smudgetool, the colors of the pixels you
drag throughare gradually dispersed until the colors dissipate completely.

6

il You can define the length of the smudge using the Pressure parameter. To
produce a short smudge, specify a low value. To specify a smudge that continues
until you stop painting with the smudgetool, specify the maximum value.

To use the smudgetool:

1. Click the smudgetool in the toolbox.
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2. Position the smudge pointer on the area you want to smudge.

 
3. Holding down the mouse button, drag to create the smudge.

 
To specify a Pressure value for the smudge tool:

1. Double-click or Option-click the smudge tool in the toolbox.

The Smudge Tool Options dialog box appears. 

Smudge Tool Options...

Spacing: | Mode:
@ Normal

Repeat Rate: [| Sie edarken Only
Pressure: [so |ka © Lighten Only
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. Enter a value in the Pressure text box from 1 to 100. For a short smudge, specify

a low value; for a smudge that continues until you stop painting, specify the
maximum value of 100.

3. Click OK.

4. Whenyou havefinished smudging the image, release the mouse button.

 
Before smudge

 
Smudgetool: 30% pressure Smudgetool: 100% pressure

Using the blur tool
Theblur tool makespart of an image less focused by diffusing the colors to which
you apply it. The blur tool works onall types of images except bitmapped and
indexed color images. You can control the intensity of the blur tool using the
Pressure parameter. To apply a strong blur effect to an image, you specify a high
Pressure value; to apply a weak blureffect, you specify a low Pressure value.

 
To use the blurtool:

1. Click the blur tool in the tool box.

2. Position the blur pointer on the area you wantto blur.

3. Holding down the mouse button, drag to blur the image.
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4. Whenyouhavefinished blurring the image, release the mouse button.

 
To control the intensity of the blur tool:

1. Double-click or Option-click the blur tool in the toolbox.

The Blur Tool Options dialog box appears.

Blur Tool Options...

- 8 8 [+] e®@e@8e
e@e@-cr.858G8

' I | | Custom

@ Normal
© Color Only
© Darken Only
© Lighten Only
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2. Enter a value from 1 to 100 in the Pressure text box. Click OK.

 
Before blur

 
Blur tool: 30% pressure Blur tool: 100% pressure

Using the sharpen tool
The sharpentool allows you to makepart of an image more focused. The sharpen
tool works onall types of images except bitmapped and indexed color images.
As you drag through part of an image, the sharpen tool increases the contrast
between adjacentpixels. This results in a sharper, more focused image.

You can control the intensity of the sharpen tool using the Pressure parameter.
To apply a strong sharpening effect to an image, you specify a high Pressure
value; to apply a weak sharpening effect, you specify a low Pressure value.

To use the sharpen tool:

1. Click the sharpen tool in the tool box.

2. Position the sharpen pointer where you wantto start sharpening the image.

3. Holding down the mouse button, drag to sharpen the image.

4. When youhavefinished sharpening the image, release the mouse button.

Chapter 6: Using the Editing Tools
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5. Release the mouse button when you havefinished sharpening the image.

 
To control the intensity of the sharpen tool:

1. Double-click or Option-click the sharpen tool in the toolbox.

The Sharpen Tool Options dialog box appears.
2. Enter a value from 1 to 100 for the Pressure.

Sharpen Tool Options...

Spacing:[5| Mode:
@ Normal

Repeat Rate: [| © Color Only
© Darken Only

Pressure: %  QLighten only
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3. Click OK.

 
Before sharpening

93

 
Sharpen tool: 100% pressure
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Chapter 7: Painting and Editing Tool Options

All of the painting and editing tools include a variety of options that allow you
to achieve particular effects. For each of the painting tools, you can choosea pre-
set brush shape or customize your own.Foreither the painting or editing tools,
you can specify which pixels are affected by the paint. You can also paintor edit
with straight lines. For certain tools, you can control the opacity, distribution,
repeat rate, and fade-outrate of the paint.

Mostof the options function in a similar manner. You can select a separate
option for each specific tool, such as a different brush shape. The options you
choosefor each tool remain in effect during the current Adobe Photoshopsession
until you choose another option.

Selecting a tool brush shape
Brush shapesfor the painting and editing tools include round, square, and linear
shapes in different sizes. You can choose a brush shape two ways: using either
the tool options dialog box, which appears when you double-click the tool in the
toolbox; or using the Show Brushes command in the Window menu, which
displays the Brushes window.

The Brushes window allows you to select different brushes easily without having
to open a dialog box each time. The Brushes window retains the brush settings
for each tool. This allows you to select a different brush for each of the painting
and editing tools. The active brush for the current tool is enclosed by a box.

You can move the Brushes window to a convenient location on the screen by
positioning the pointer on the gray bar at the top of the window anddragging.

To remove the Brushes window from view,either click the window's close box,
or choose Hide Brushes from the Window menu.

To choose the brush shape you wantfor a particular tool:

1. Double-click or Option-click the painting or editing tool in the toolbox you
want.

oL
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The options dialog box for that tool appears.

Paint Brush Options...

Mode:

@ Normal
© Color Only

Repeat Rate: [| O Darken Only© Lighten Only

Opacity: (oo

 
2. Click the brush shape you wantto use.
3. Click OK.

To select a brush from the Brushes window:

1. Choose ShowBrushes from the Window menu.

The Brushes window appears.

| Custom 
2. Click the painting or editing tool you wantin the toolbox.

3. Click the brush you want.

A box appears aroundthe brushto showitis selected.
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Selecting a custom brush shape

 

 

You can define a custom brush shapeto suit your needs. The brush shape you de-
fine can be no more than 64-pixels-by-64-pixels in size and should appear on a
solid white background, The custom brush youdefine is placed amongthe brush
shape optionsforall of the painting tools. The brush is labeled “Custom”in the
tool dialog boxes and the Brushes window.

Only one custom brushshape at a time can beactive forall the tools. However,

you can create a variety of custom brushes, store them in a document, then open
that document andselect the one you want to use at a particular time. To define
brushes with soft edges, you can select brush shapes composedof pixels with gray
values other than 0 (black) and 255 (white).

To define a custom brush shape:

. Click the rectangular marquee tool in the toolbox.

2. Holding down the mouse button, drag the marquee to enclose the part of the
image you want to use as a custom brush. 

 

Selecting a custom brush Painting with a custom brush

. When the marquee encloses the part of the image you want, release the mouse
button.

. Choose Define Brush from the Edit menu.

The selected custom brush is placed in the Brushes window and in the painting
and editing tools dialog boxes.

_ © © @ @ @ @

@e@@.onuHat V)
re | | ,
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Specifying paint distribution
You can specify the distance betweenthepixels that are affected by each painting
and editing tool. For example, if you specify 12 pixels as the spacing valuefor the
pencil, the pencil lays down a mark once every 12 pixels as you drag across the
image. If you specify 0, the distribution of paint is based on the speed of the
mouse movement.If you drag quickly across an image, gaps probably will appear
in the trail of pixels left by the tool. A spacing value other than 1 is useful when
you paint with a large, custom brush.

To specify a spacing value for a painting or editing tool:

1. Double-click or Option-click the desired painting or editing tool in the toolbox.
The options dialog box for the selected tool appears.

2. Click in the Spacing text box.

3. Enter a value from 1 to 999 for the spacing value you want,
4. Click OK.

 
Paint brush spacing parameter: 0 Paint brush spacing parameter: 40

Specifying the paint opacity
You can specify how opaque you want the paint in your imageto be using the
Opacity option for the painting tools. The Opacity option allows you to use paint
that ranges from nearly transparent to opaque. To use transparentpaint, you
specify a low percentage value; to use opaquepaint, you specify a high value.

To specify a value for the opacity of the paint:

1. Double-click or Option-click the desired painting tool in the toolbox.

The options dialog box for the selected tool appears.

2. Double-click in the Opacity text box.
3. Enter a value from 1 to 100.
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4. Click OK.

_inv
Paint brush opacity value: 30% Paint brush opacity value: 80%

Specifying the paint repeat rate
With the exception of the pencil, line, eraser, and rubber stamp tools, you can
specify the rate at which paint is deposited on the image by the painting and
editing tools when the mouseis stationary. The higher the Repeat Rate value, the
more paint is deposited on the image.

In the case of the editing tools, like the blur tool, the Repeat Rate controls how
fast the operation is performed when the mouseis motionless. For example, to
blur an image a lot in a short time, you specify a high value for the Repeat Rate,
and hold down theblur tool on the area you wantto blur.

To specify the repeat rate for a painting or editing tool:

. Double-click or Option-click the desired painting or editing tool in the toolbox.

The options dialog box for the selected tool appears.

. Click in the Repeat Rate text box.
3. Enter a value from 1 to 60.

. Click OK.

ule
Airbrush repeatrate: 50 Airbrush repeatrate: 1
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Specifying the paint fade-out rate
You can specify the rate at which the paint brush andairbrush fade out as you
paint with them to simulate an actual brush stroke. The fade-out rate determines
how manypixels are colored with each stroke before the paint fades out com-
pletely. The higher the fade-out value, the longer the paintwill flow before it
fades out. You canalso specify a negative value to make the paint fade from the
foreground color to the backgroundcolor.

To specify the fade-out rate for the paint brush and airbrushtools:

1. Double-click or Option-click the paint brush or airbrush tool in the toolbox.

The options dialog box for the selected tool appears.
2. Click in the Fade Out text box.

3. Enter a value from -999 to 999,

4. Click OK. 

 
Airbrush fade-out rate: 60 Airbrush fade-out rate: 120

Selecting a painting mode

User Guide

You can control which pixels are affected by paint according to the painting
mode you choosefor a painting or editing tool. The modes include Normal,
Darken Only, Lighten Only, and Color Only. In the default Normal mode,all the
pixels you apply paint to are changed to the foreground color, But you can also
choose to work in a mode in which onlypixels lighter or darker than the fore-

groundcolor are changed. Or, you can choose a modethat changes only the hue
andsaturation ofa pixel.

To choose the painting mode you wantfor a painting or editing tool:

. Double-click or Option-click the desired painting or editing tool in the toolbox.

The options dialog box for the selected tool appears.

. Click the mode you want.

. Click OK.

Following are descriptions of how the modes work.
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Normal

Whenthe Normal modeis active, each pixel you apply paint to is changed to the
foregroundcolor. This is the default option, and how the painting andediting
tools normally operate.

 
Darken Only

When the Darken Only modeis active, only the pixels that are lighter than the
foreground color are changed to the foregroundcolor. Lightness is measured by
the pixel’s brightness value. The pixels that are darker than the foreground color
are not changed.

 
Lighten Only

When the Lighten Only modeis active, only the pixels that are darker than the
foreground color are changed to the foregroundcolor. Thepixelsthat are lighter
than the foreground color are not changed.
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Color Only

Whenthe Color Only modeis active, all of the pixels you apply paint to are
changed to the foreground color, but their luminosity values are not changed.

This preserves the texture in the image. This modeis useful for coloring mono-
chrome imagesorfor tinting color images.

 
NOTE: Luminosity is a color parameter that measures the brightness ofa color.
Luminosity is expressed as a value. The value is computed as the weighted average of
the pixel’s RGB values, expressed as a percentage. The expressionis: Luminosity =
(.30 x Red) + (.59 x Green) + (.11 x Blue).

Painting and editing with straight brush strokes
Using the Shift key, you can paint straight brush strokes with the pencil, paint
brush, airbrush, and rubber stamppainting tools, and you can edit straight paths
with the editing tools.

To paint straight brush strokes or edit straight paths:

1. Select the desired painting or editing tool from the toolbox.

2. Click the image where you wantthestraight brush stroke or path tostart.

3. Hold downtheShift key.

4. Position the pointer where you wantthe straight brush stroke or path to end.
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5. Click the mouse button.

ctsfl

6. Continue movingthe pointer and clicking the mouse button until you have
definedall of the straight brush strokes or paths you want.

To resume defining freehand lines:

7. Release the Shift key.

8. Drag to define a freehandline or an irregular path.
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— Chapter 8: Using the Type Tool

em The Adobe Photoshop program allows you to enter bitmapped type on an image
using the type tool. This chapter describes how to use the type tool to enter type

f— on an image. It covers how to select type options, including typeface, size, lead-
ing, and styles; and how to add, edit, move, and align type.

Bitmappedtypeis different from the outline type that is generated in object-

oriented applications. Bitmapped type is rendered at the resolution of the image.
For example, if the resolution of the image is 100 pixels per inch, the resolution
of the type in the imageis also 100 pixels per inch.

Outline type is rendered at the resolution of the output device. If the output
= device's resolution is 2500 dpi, then the outline type is rendered at 2500 dpi.Also,

you can edit (delete and change thefont, size, and style of characters) outline

-~ type, but you cannotedit bitmapped type in the Adobe Photoshopprogram after
you haveplaced it on the image.

= Normally, large bitmapped type appears jagged on thescreen. Butif you use
Adobe Type Manager™ (ATM™) software, the type appears as smooth andas well-

= defined as outline type.

You have a numberof options to control the type you enter. You can specify the
typeface and pointsize, and select style options like underlining anditalics. The
options you select remain in effect until you change them or quit the Adobe
Photoshop program.

Using type in an image
To use type in an image, youselect the type tool, click on the image where you
want the type to appear, then enter the type you want into the Type dialog box.
The samedialog boxlets you select type options. When youclose the Type dialog
box, the type appears selected on the image.

= While the type is selected, you can movetheentire text block or just individual
characters. This allows you to kern, or adjust the letterspacing, in the type.

To adjust the letterspacing, you can choose to either deselect certain characters
in a text block and move the remainingselected characters, or select the charac-
ters you want to move and deselect the other characters in the text block. Once
you deselect the type, it becomes part of the image, and you can only change the
type by editing the pixels that comprise the characters.
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To enter type in an image:

T 1. Click the type tool in the toolbox.
2. Position the pointer where you wantthe type to appear on the image.

The pointer changesto the I-beam pointer.

3. Click the mouse button.

The Type dialog box appears.
  

Font:

Size: [point|

Leading: [|
Spacing: [|
Style: Alignment:

C Bold C] Outline @ Left
CO Italic LC Shadow © Center
(Underline ([) Anti-aliased © Right 
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4, Enter the type you wantin the text box, up to 255 characters at a time. The type
automatically wraps at the right margin of the box, but appears as one continu-
ous string on the image. To specify a line break, press the Return key; or click
where you wantthe line to break, and press the Return key.
    

Font:[Geneva

Size:

Leading:

Spacing:

Style: Alignment:
(1 Bold C Outline @ Left
CJ Italic CJ Shadow © Center
(J Underline [() Anti-aliased © Right 

To break a line, click where you want the line to break,
and press the Return key. 

If you reach the bottom of the box while entering type, the type automatically
scrolls up.

5. Click OK.

Scrolling the type

To scroll the type up or down:
1. Click in the text box.

2. Holding down the mouse button, drag in the direction you want toscroll.

The typescrolls in the direction you drag.

3. When the type you wantis displayed, release the mouse button.
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Editing type
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You can edit type in the Type dialog box using standard Macintosh text-editing
procedures. There are two waysto select the type in the text box that you want
to edit, described below. Oncethe text is placed on the image anddeselected, you
can no longeredit it.

To delete type in the text box:

1. In the text box in the Type dialog box, click to the right of the type you want to
delete.

2. Press the Delete key to backspace over type.
   
 
 
 
 
 

Size: [12|
Leading:[
Spacing: [|
Style: Alignment:

(Bold L] Outline @ Left
UC Italic LJ Shadow © Center
O1Underline’ [| Anti-aliased © Right 

To edit the type in the text box:
1. Click behind the type you want to delete.
2. Press the Delete key to backspad over type. 

To select a single word, double-click the word.
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To select a block of text, method 1:

1. In the text box in the Type dialog box, click where you wanttheselection to
begin.

2. Holding down the mouse button, drag until the block of text you wantis
selected, then release the mouse button.
   

Font:

size:

Leading: [|
Spacing: [|
Style: Alignment:

L] Bold Outline @ Left
CJ Italie UJ Shadow © Center
[] Underline []Anti-aliased © Right 

To select a block of text:

Bi TKeUTC EEendetaCL COCy tT
2. Holding down the mouse button drag until the block of

(CH eaeeecin then release the mouse
button.

 
 

To select a block of text, method 2:

1. Click where you wantthe selection to begin.

2, Without pressing down the mouse button, position the pointerto the right of
the text you wantto select.

3. Hold down the Shift key, and click the mouse button.

The blockis selected from the starting point to the end point you specified.

The steps below describe how to chooseattributes for type, including font, size,
leading, andstyle.
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Choosing a font

To choose the font you wantto use:

1. In the Type dialog box, position the pointer on the box next to Font.
2. Hold down the mouse button.

A pop-up menulisting the fonts available in your system appears.
he,

Geneva
Helvetica
Monaco 

3. Drag until the font you wantis highlighted, and release the mouse button.

The nameof the font you chose appears in the box.

Choosing a fontsize
You can choose to specify the size for the type in either points or pixels, from 4
to 1000. The size range may beless if points are the unit of measure and resolu-

tion is not 72 dpi.

To specify the unit of measure you wantto use for the type:

1. In the Size text box in the Type dialog box, position the pointer on the box
labeled either “point” or “pixel.”

2, Hold down the mouse button.

A pop-up menu appears.

3. Drag to highlight the unit of measure, and release the mouse button.

 
The chosen unit of measure appears on the box.

To specify the size of the type:

1. Double-click in the Size text box.

2. Enter a value from 4 to 1000.
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Selecting style options for type
You can apply Style options to type so that it appears underlined,in italics,
shadowed, outlined, and bold.

The Style options have a cumulative effect on type. For example, if you select
Shadow and Underline, the type appears both shadowed and underlined on the
image.

To select the Style options you want, click the desired style options in the Type
dialog box.

As you select an option, the box beside it is checked. To revert to plain type,
uncheckall of the Style options.

 
Entering anti-aliased type

Theanti-aliased Style option lets you enter type with edges that appear smooth.
The smooth edgesallow the type to blend into the background. Youwill probably
wantto use anti-aliased type in an image, except when you enter type in small
pointsizes.

Theanti-aliased Style option requires that you use a font that has a bitmapped
screen font that is two, three, or four times the size of the type you are entering,
unless you are using ATM software and the desired fontis installed in your sys-
tem. For example, if you apply the anti-aliased option to 12-point Times, you
must have installed on your system a 24-point, 36-point, or 48-point size Times
screen font,
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To apply the anti-aliased type option to your type, click the Anti-aliased Style
option.

Type with anti-aliasing Type withoutanti-aliasing

Choosing the character spacing

You can control the spacing between characters, called kerning, in a text block
using the type tool’s spacing parameter. The spacing parameter uses the same
unit of measure that you specified for the font size. Enter positive values to
increase the spacing; enter negative values to decrease the spacing. Spacing incre-
ments can be as small as tenths of a pointor pixel.

To specify a value for character spacing:

1. In the Type dialog box, click the Spacing text box.
2. Enter a value from -99.9 to 999.9,

Choosing the line spacing

User Guide

You can choose theline spacing, called leading, you wantfor type. The line
spacing is measured from baseline to baseline of thelines of text. By default, the
leading built into the font is used. The leading uses the same unit of measure you
specify for the fontsize, either points or pixels.

To specify the amountof line spacing you wantto use:

1. Click in the Leading text box in the Type dialog box.

2. Enter a value from 1 to 1000 to specify the spacing betweenlines of text.
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Aligning type
You can choose how to align type according to the point you clicked on with the
type tool pointer. If you wantto align the type so that it is centered on the image,
choose the type tool, click on the center of the image, then choose Centeralign-
ment in the Type dialog box.

To choose the type alignment option you want,click the Left, Center, or Right
button,

left center right
aligned type alignedtype aligned type 

Completing the type selection
Whenyouhaveselected the type options you want to use and you have finished
entering the type, click OK.

The type appears selected on the imageandisfilled with the current foreground
color. While the type is selected, you can modify it as you can any otherselection.
Thatis, you canfill it, rotate it, transform it, and so on.

 
Once youdeselect the type, it becomespart of the image. You can select the pixels
in the type as you wouldotherpixels in the image, then modify the pixels. How-
ever, you cannot changethe type attributes of type onceit is placed on the image.
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Moving type on the image
You can movethetext block, as long asit is still selected, to where you wantit to
appear on the image.

To move the type:

1, Position the pointer on one of the characters in the text block until the arrow
pointer appears.

2, Holding down the mouse button, drag the text block to where you wantthe text
to appear.

3. When you have positioned the typeas desired, release the mouse button.

CPUS Tipe ote
44 as
L6G jinaee

Moving type on

ihe cm 
Special type selection options

While a text block is selected on an image andthe type toolis active, you can de-
select individual characters and words in the text block, and movethe characters

that arestill selected. This allows you to move characters closer to adjust the
letterspacing, or kerning, or simply move certain characters to another position
on the image.

The type tool allows you to select the parts of an image you want to modify.
While the typeis still selected, the type tool is active, and when you press down
the Commandkey and mouse button, the Type tool pointer changesto the lasso
tool. The lasso tool then worksin a special way to allow youto deselect characters
in a text block.

To deselect characters in a text block:

1. Make sure that the type toolis selected.

2. Hold down the Command key.

The pointer turns into the lasso.

3. Holding down the mouse button, drag the lasso around the character or charac-

ters you do not want to adjust.

90 User Guide

114



115

4, Whenthe characters are enclosed by the lasso, release the mouse button and the
Commandkey.

The characters you encircled with the lasso are deselected.

 
You can now move or modify the other characters in the text block without
affecting the characters you deselected.

If you want, you can use a similar procedure to select the characters you want to
move and deselect the other characters.

To select the characters you want to move:

1. Hold down the Shift and Commandkeys.

2. Holding down the mousebutton, drag the lasso tool around the characters you
want to remain selected.

The characters you encircled with the lasso tool remain selected, and the other
characters are deselected. You can now movetheselected characters closer to the

deselected characters to kern the type.

3. Whenthe characters you wantare enclosed bythelasso tool, release the mouse
button and the Shift and Commandkeys.

ci

OGL  
NOTE:Makesure that youencircle the entire character you wantto select; any portion
of a character outside the lasso tool will not be selected.
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To adjust the letterspacing:

1. Position the pointer on one of the selected characters.
2. Hold down the mouse button.

3. Whenthe arrow pointer appears, drag the characters until you are satisfied with
howthe type looks. To constrain the movementto a straight line, hold down the
Shift key.

4, If you constrained the movement, release the mouse button and theShift key.

5. Deselect the type.

ments. Simply press the arrow key that points in the direction you want to move the| NOTE: You can use the arrow keys to move the selected characters in 1-pixel incre-
type.
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Chapter 9: Making Selections

This chapter describes how to use the Adobe Photoshop program selection tools
and commandsto select parts of an image. The Adobe Photoshop program selec-
tion tools allow youto select images in a variety of ways and with a range of
precision. The chapter also describes alpha channels and how to modify,edit,
andstore selections. An alpha channelis an 8-bit, gray-scale representation of an
image.

In addition to the standard lasso and marqueeselection tools, you can also use
the magic wand tool to automatically select images. This tool lets you select parts
of an image based on the similarity of colors. This way, you can easily select a
specific part of an image without having to laboriously trace its outline. You can
also add to and subtract fromaselection.

Theselection remainsin effect until you deselect it. Once youselect a portion of
an image, you can modify it withoutaffecting the rest of the image. For example,
if you drag the eraser through a selection and continue through a part of the
image that isn’t selected, the non-selected portion of the image remains un-
changed. You canflip, rotate, and freely moveselections, as well as adjust their
color characteristics.

Using the selection tools
The selection tools include the lasso tool, the rectangular andelliptical marquees,
and the magic wand. These tools and their commandsare described in the fol-
lowing section.

Using thelasso tool

The Adobe Photoshop program lets you isolate areas of an image using several
selection tools, including the marquee andlasso tools. The lasso tool is a freehand
tool that lets you define any arbitrary selection area. You can use thelasso tool to
trace the outline of a selection. Once you makea selection, you can addtoit or
subtract from it. You can also use the lasso tool to select straight line segments,
or a combination of straight and freehandlines. The pixels in the selection will
be affected by the changes you specify.
To use thelasso tool:

. Click the lasso tool in the toolbox.

2. Position the lasso pointer where you wanttheselection to begin.

3. Holding down the mouse button, drag to trace the outline of the selection area.
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4. To close the selection border, release the mouse button.

 
You can either drag to the starting point of the selection and release the mouse
button to complete the selection, or release the mouse button when you have
enclosed most of the selection. When you release the mouse button before the
selection is completed, a straight line is projected to the beginning of the selec-
tion to complete the selection for you automatically.

 
Addingto and subtracting fromaselection

If you have notselected the area you wanted, you mayalter the selection by
adding to it or subtracting from it.
To add to a selected area:

1. Holding downtheShift key, then press the mouse button, drag to trace the out-
line of your selection to addit to the original lassoed selection.

NOTE:Ifyouclick the mouse button withoutfirstpressing the Shift key, youwill lose
the first selection,

2. When you havefinished making yourselection, release the Shift key and the
mouse button.

A newlasso appears aroundthetwoselections.
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To subtract from a selected area:

1. Hold down the Commandkey, and press the mouse button.

-wN

. Trace the outline of the selection. Make sure that you completely surround the
first lasso border. If you do not connect the end points of the newlasso thatis
selecting the area to be removed, youwill bisect the lasso into two, separate lassos.

. Release the Commandkey and the mouse button. The new,reduced lasso appears
aroundthe selection.

Selecting a combination of straight and freehandlines with the lasso tool

While you use the lasso tool, you can use the Option key to define straight line
segments. This featureis useful for selecting parts of an image that contain recti-
linear shapes, such as a window, a door, or a box.

You can use a combinationofstraight line segments and freehand drawing with
the lasso tool. This is useful on objects that combinestraight lines and curves. As
you select a combination of straight and freehand lines, you must continue
holding down the Optionkey. Click to define starting and end pointsof straight
line segments; to draw freehandlines, hold down the mouse button and drag.

To select a combination of straight and freehand lines using the lasso tool:
. Press down the mouse button.

. To define the selection area, hold down the Option key.

. Release the mouse button where you wantthe straight line tostart.

. Position the pointer where you wanttheline to end, and click the mouse button.

A selection line is attached to the pointer.
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To define additional straight line segments, continue repositioning the pointer
and clicking the mouse button.

 
NOTE: You must continue to hold the Optionkey ora straight line will automatically
be drawn between the two ends ofthe lasso,

5. To resume defining freehandparts of the selection, press down the mouse button
and drag instead of moving the pointer and clicking.

 
6. When you havefinished making yourselection, release the mouse button and

the Option key.

NOTE: You can move a lassoedselection. To do so, position the lasso pointer inside
the selection, press the mouse button, and drag the selection to the desired location.
Release the mouse button. To undo the move, choose Undo from the Edit menu.

Using the marqueetools

The Adobe Photoshop program includes a rectangular marquee to make rectan-
gular-shaped selections andanelliptical marquee to makeelliptical-shaped selec-
tions. The optionsavailable for both tools are very similar. You can specify a fixed
size in pixels, as well as a height-to-width ratio, when using these tools. Both tools
include the option of specifying the horizontal and vertical dimensionsofthese-
lection marquee.
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The rectangular marqueetoolalso lets you select a single row or columnofpixels
on the image. The options youselect for the tools remain in effect throughout
your Adobe Photoshopsession or until you change the options.

To use the rectangularorelliptical marquee tool:

1. Click the desired marqueetool in the toolbox.

2. Position the marquee pointer where you wantto begin theselection.

3. Hold down the mouse button, and drag in a diagonal direction to enclose the
selection with the selection border.

The selection border appears around the selection.

 
. When you have enclosed the selection with the border, release the mouse button.

Selecting a single row or column of pixels

You can use the rectangular marqueetoolto select either a single row or a
column, one-pixel wide, on the image. You can cut, copy, and otherwise modify
the one-pixel line as you would anyotherselection.

To select a row or columnof pixels on the image using the rectangular
marquee:

Double-click the rectangular marquee tool in the toolbox.

2. Click Single Row to select a single horizontal rowofpixels or click Single Column

oefoyeeee
to select a single vertical column ofpixels.
Click OK.

Position the marquee pointer near the row or column you wantto select.
Hold downthe mouse button.

Drag to position the selection border on the row or column you want toselect,
then release the mouse button.
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A single selection line appears on the drawing.

 
Creating selections from a corner or from the center
You can define a selection from either a corner or from the center of the rectan-

gularor elliptical marquee. By default, when you define a marqueeselection, you
define it from a corner. You use the Option key to define the selection from the
center.

To create a marquee selection from the center:

. Click either the rectangularor elliptical marquee tool in the toolbox.

. Position the pointer where you wantthe center of the selection to appear.

3. Hold down the Option key and mouse button, and drag to define the selection

[23] +
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marquee,

. When you havedefined your selection, release the mouse button.

Defining a fixed size for the marqueetools

You can define a fixed size for each of the selection marquees. Instead of defining
the size of the selection border by dragging with the mouse, you can use this
option to specify values for the height and width of the selection marquee. This
option is useful when you wantto select an area of a specific size.

To specify a fixed size for a marqueetool:

Double-click or Option-click either the rectangularor elliptical marquee tool in
the toolbox.
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The dialog box for the selected marquee tool appears.

Rectangular Marquee Options...

@ Normal

© Constrained Aspect Ratio:

width: [1|
Height: [1|

© Fixed Size:

Width: (pixels)

Height: (pixels)

© Single Row

© Single Column

 
 

. Click Fixed Size.

. Enter the value you wantfor the width (in pixels),

. Press the Tab key or double-click in the Height text box.

. Enter the value you wantfor the height (in pixels).
. Click OK.

To define a marquee with the dimensions entered above:

. Position the marquee pointer in the lower-right corner of the area you want to
select.

. Holding down the mouse button, drag to position the marquee where you wantit.

Fixed size of 125 by 75 pixel marquee

Release the mouse button.
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